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1 Introduction

Welcome to the pCon.planner online help

The  pCon.planner  online  help  contains  all  important  information  you  need  to  know  for
using  the  software.  You  can  use  it  as  a  tutorial  to  get  to  know  the  different  tools,
functions and operations. Otherwise you can use it as a reference guide.

The online help consists of the following three chapters:

Introduction

The introduction summarizes pCon.planner and tells you what it can achieve for you. You
will  learn  everything  you  need  to  know  about  download,  installation  and  updates.
Furthermore you will get to know how to use the online help.

Link to chapter "Introduction"

User Interface

This  chapter  introduces  the  user  interface  of  pCon.planner.  Step  by  step  you  will  learn
about thedifferent components of the program. The chapter  provides  you with  important
knowledge about how to work with the software. 

Link to chapter "User Interface"

Furnishing with the pCon.planner

This chapter deals with the interior design and furnishing planning.  From scratch you will
learn how to carry  out  the planning,  which  important  things  you need  to keep  in  mind
and how to efficiently and successfully work with the software.

Link to chapter "Furnishing with the pCon.planner"



- 2 - Copyright © 1995 - 2009 EasternGraphics. All rights reserved.

1.1 What is the pCon.planner?

The  pCon.planner  by EasternGraphics  is  a professional  and  easy-to-use  space  planning
and  furnishing  software.  The  application  allows  you  to  create  complex  furnishing
concepts in a comfortable  and professional  way,  and  to  visualize  these  concepts  in a
photo-realistic quality.

The pCon.planner provides you with the following features:

Room design

The program features powerful functions particularly optimized to plan and modify rooms
and buildings.  With intuitive tools  you design entire  living  and  working  environments,
which could be anything from a small room to a complex  office  floor.  Just  as  easily  you can
allocate colors and materials and simulate lighting situations.

Furnishing design

To design the furnishing, the pCon.planner can handle different data formats such as DWG,
SKP or OFML. In the program the user  has access  to  various  online  3D libraries,  such  as
pCon.catalog  –  a  web  browser  compiling  a  steadily  growing  number  of  web  catalogues  of
numerous  manufacturers  and  dealers  in  the  furnishing  industry  –  or  the  Google  3D-
Warehouse. There you can chose  suitable objects and  load  them directly  into your  design
project. 

Graphical presentation

For construction and presentation purposes the pCon.planner provides various  qualities
of visualization and camera perspectives,  each  of  which  is  realized with  fast  real-time
rendering. This allows you to move live and interactively through your planning. 

Just click here  to  have  a look  around the  online  gallery  of  the  pCon.planner 6  website.
There you can get an impression of the brilliant rendering quality. 

http://www.pcon-planner.com/gallery/
http://www.pcon-planner.com/gallery/
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1.2 Download, installation and updates

Download

pCon.planner  can  be  downloaded  easily  and  free  of  charge  from  the  pCon.planner
website. Follow the link to the download website for the current version of the software.

Installation

Double-click  the  downloaded  file  for  installation.  Before  installation,  check  the  system
requirements to make sure your computer is compatible with the software.

The installation process is very easy and does not require any special knowledge. 

Updates

The  pCon.planner  updates  are  made  available  regularly  and  free  of  charge.  You  can
chose from the following two options:

Either:

· You use the pCon.planner automatic update service. By default this option (“automatic
check for new versions”) is already activated in the Application Menu under “Settings”  on
the Online tab.

Or:

· You click the Updates button on the Help tab in the  Ribbon  to  search for  pCon.planner
updates.  This  manual  method  is  useful  if  you  have  deactivated  the  automatic  update
service.

If  an  update  is  available,  simply  follow  the  on-screen  instructions  for  download  and
installation.

http://www.pcon-planner.com/download/
http://www.pcon-planner.com/download/
http://www.pcon-planner.com/download/systemanforderungen.html
http://www.pcon-planner.com/download/systemanforderungen.html
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1.3 How to work with the online help

This  article  gives  you  hints  on  how  to  use  the  online  help.  It  answers  many  questions
potentially arising in the context of the online help.

What does the online help do for the user? 

The goal of the online help is to introduce the user interface, the functions and the tools
of  the  pCon.planner  in  such  a  way  that  you  are  able  to  independently  operate  the
software.

Apart from the  introduction,  the  online  help  consists of  two  big  sections.  In  the  chapter
“User  Interface”  you get  to  know the  different  elements  of  the  pCon.planner  interface,
which gives you an impression of functions and capabilites of the software.

The third part of the online help – the chapter “Furnishing with the pCon.planner” – discusses
the  tools  and  operations  provided  by  the  pCon.planner.  Numerous  examples  with
illustrations  and  descriptions  familiarize  you  with  the  software.  This  will  enable  you  to
quickly implement your ideas and concepts.

Why are some terms displayed in bold letters?

The most important terms in the online help are highlighted in bold letters. This  enables
you to have a broad overview  of  the  content  without reading  the  entire text  in  detail.
Certain software-specific terms are also printed in bold.

What are tabs and groups?

The online help regularly refers to tabs and groups. These terms refer to the structure of
the  Ribbon.  As  illustrated  in  the  figure  below,  the  commands  are  organized  in  logical
groups, which are pooled on superordinate tabs. In  the  example  below,  the  Home  tab  is
activated. The related groups are Clipboard, Tools, Room and Insert. 

Figure 1
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1.4 Technical hints and tips

This page provides hints and  tips  to  effectively  counteract  problems  with  the  graphical
display of the pCon.planner.

Contents

1.General hints on graphics

2.Before installation

3.Not supported rendering modes

4. Improvement of processing speed

5.ATI graphics cards

6.Refresh rate

General hints on graphics

· The  pCon.planner  may be limited in  regard  to  the  quality  of  display  and  processing
speed if used with graphics hardware older than two years.

· Make  sure  that  the  up-to-date  graphics  card  driver  is  installed  on  your  computer.  If
required ask your IT personnel or system administrator.

· We  recommend  a  color  quality  (desktop  color  depth)  of  32  bit.  If  problems  with  the
display arise, test whether a change to 16 bit solves the problem.

· If  you  are  using  a  notebook,  we  recommend  using  a  stand-alone  graphics  card.
Onboard graphics hardware is often less powerful.

Before installation

· Make sure  your  computer  is  suitable  for  the  installation  of  pCon.planner.  To do  this,
please refer to our suggested requirements and minimum requirements.

· Install  the  up-to-date  driver  of  your  graphics  card  or  inquire  with  your  system
administrator about the current driver status.

Not supported rendering modes

It is possible, that your system does not support all rendering modes of the pCon.planner.
If this is the case, the note displayed below (Figure 1) will pop up each time you start the
program.  In  the  Render  group  (View  tab),  the  unsupported  rendering  modes  are
replaced  with  the  icon displayed  below  (Figure  2).  Install  an  updated  version  of  your
graphics  card  driver  or  inquire  with  your  system  administrator  about  the  current  driver
status. An update of the graphics card driver usually solves rendering mode problems.

http://www.pcon-planner.com/en/download/system-requirements.html
http://www.pcon-planner.com/en/download/system-requirements.html
http://www.pcon-planner.com/en/download/system-requirements.html
http://www.pcon-planner.com/en/download/system-requirements.html
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Figure 1

Figure 2

Improvement of processing speed

· The  rendering  modes  of  the  pCon.planner  differ  in  processing  speed.  With  newer
graphics  cards,  the  Conceptual  mode  is  usually  fastest.  In  combination  with  older
graphics cards, however, the Shaded mode is faster. Try the different modes to find out
how each one of them works on your computer.

· By  default,  synchronization  of  center  and  zoom  of  the  orthographic  views  are
deactivated  (see  "extended  rendering  options").  If  these  options  are  activated,  the
software needs more system resources. If not sufficiently available, the processing speed
is slowed down.

· If  you  are  carrying  out  large  plannings,  or  if  your  computer  does  not  meet  the
suggested requirements,  we  recommend  to  not  subdivide  the  workspace.  Instead
choose Single workspace on the View tab.

· In combination with older graphics cards, the processing speed may be increased  by
decreasing the size of the user interface.

ATI graphics cards

In ATI graphics cards, the “A.I.” setting is activated by default. This may lead to incorrect
display of textures in the pCon.planner. Deactivate this setting to improve the display.

Refresh rate

Modifying the refresh rate of your screen may increase the processing speed  of three-
dimensional views. Check which refresh rate setting suits best for your  screen before  you
operate pCon.planner.

2 User Interface

This chapter focuses on the pCon.planner user interface with its different elements. You will
gain knowledge of the Application Menu, the Quick Access Toolbar, the Ribbon, the work
area and the Status Bar. 

Figure 1 displays the user interface with its five elements.

The topics of the chapter are listed in the following table of contents.
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Figure 1
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2.1 The Application Menu

You  can  access  the  Application  Menu  by  clicking  the  pCon.planner  icon.  This  is  the
orange button in the upper-left corner of the user interface (see Figure 1).

Figure 1 shows the different commands within the application menu. It is surrounded by a
red line.

The links below take you to more detailed information on each of the commands.

Figure 1
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2.1.1 Create a new drawing

A new empty document is opened each time you start the pCon.planner. You can also
open a new drawing by clicking  “New” in the Application Menu.  

2.1.2 Open an existing drawing

The right-hand side of the Application Menu lists the “Recent Documents”. Simply click to
open  any  of  them.  To  open  documents  which  are  not  listed  here  click  “Open”  and
navigate to the desired document.

The pCon.planner supports the following file formats: 

· DWG

· DXF(parametric)

· 3DS (3D Studio)

· SAB, SAT (ACIS SAT)

· SKP (SketchUp)

· FML (OFML-scene)

· ENV (OFML-ambience)

· OBK (pCon.basket project)

2.1.3 Save a drawing

To  save  a  drawing  click  “Save”  or  “Save  as”  in  the  Application  Menu.  The  save  dialog
window opens. Select a destination and enter the file name. Under “File type” you can
choose between different versions of the DWG format (R15 to R17).  We recommend to
save your data as R17. 

2.1.4 Save a selection

Via the entry "Save Selection..." you can export any selection of objects as DWG file.

Click  "Save  Selection"  in the  Application  Menu. In  the  file  dialog  box select  the  destination
directory and enter the output format and a file name.

The  dialog  "Filetype"  allows  you to  select  a version  (R15  to  R17)  of  the  DWG  format.  We
recommend to save your data as R17.

Press "Save".

2.1.5 Import

Via the  „Import“-command  in  the  Application  Menu  you can import  data  in  DWG,  DXF,
SAT, 3DS, SKP, FML, ENV- and OBK file formats into your current project. 
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Follow the following steps:

1.Click “Import” in the Application Menu.

2. In the following dialog box choose the files which are to be imported. 

3.Click “Open”.

4.You can place the data anywhere in the viewport.

2.1.6 Export

A drawing can be exported as a geometry, or as an image.

Export as geometry

Click “Export” in the Application Menu, then click “Geometry”. In the following  dialog  box
navigate to the appropriate folder and assign a file name.

Click “Save”.

Export as image file

Click  “Export”  in  the  Application  Menu,  then  click  “Image”.  In  the  following  dialog  box
navigate to the appropriate folder, select a filetype  (BMP, JPG, PNG or TIF) and assign a
file name. Click “Save”

The dialog  box “Image  export”  opens,  where you can specify width  and height  of  the
image, aspect ratio as well as image quality and background color. If you activate "Use
View background", the image adopts the current background color of the active view.  

Click “Generate image”. A picture of the active view is now generated.

2.1.7 Print

With the print dialog of pCon.planner you can print drawings on paper or export a drawing
as pdf file.

Print a selection

You have the possibility to print only  a selection  of your  drawing.  To do  so  navigate  to  a
suitable  view and  click  "Print"   in  the  Application  Menu  (see  Figure  1).  In  the  submenu
"Print" you can select "Print", "Quick Print" and "Print Preview". 

When you select "Print" you get  to  the  Print  Setup  dialog box where  you can adjust  the
printer and the page settings. Press Print to print the current view.

With "Quick Print" you skip the Print Setup dialog and print right away. 

Select "Print Preview" to see a preview of the printout. Change the settings if required. 
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Figure 1

Figure 2 shows the Print Setup options. You can select a printer, the paper size and the
margins. In  the  "Options" you can adjust  the quality  and  the  background color  of  the
printout.

If  you wish  no  white  background  color,  you select  any other  color  and  activate  "Use  view
background". The printout will adopt the current background color of the active view. Select
"Print greyscaled image" to print in greyscale. Furthermore, you can adjust the printer setting
under "Properties" or have a preview displayed.

Under "Printer" you can select any real printer or file printer (e.g. pdf printer). Of course, you
can only select file formats that can handle image content.
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Figure 2

Figure 3 displays the print preview. The menues, legends,  coordinate axes or  any  other
components of the program itself  are  not  printed.  In  this  case  the  drawing  is  printed  in
landscape format. Under "Properties" you can change this setting. 

Use the Print button in the upper left corner of the print preview to directly print the image.
You  don't  need to  return  to  the  menu.  Furthermore,  you can zoom in  or  out  on the  print
preview via the relevant buttons. To quit the print preview press "Close" or ESC.
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Figure 3

Print PDF

The  print  dialog  allows  you to  export  a  pdf  file of  the  current  view.  Simply  select  a  pdf
printer instead of a real printer. Of course this depends on the software and pdf printers that
are installed on your system. 

2.1.8 Send an e-mail

Via the  entry  "E-Mail"  in  the  Application  Menu  you  can  send  an  open  DWG  drawing  as
attachment to an e-mail to friends, colleagues or business partners.

2.1.9 Purge planning

Via the entry "Purge" in the Application Menu you can reduce the filesize your your planning:
unused layers,  blocks,  styles  for  measurements,  texts  and  lines  are  removed  automatically
from  your  planning file.  An  example:  When  you  delete  an  object  from  your  drawing,  pCon.
planner  removes  the  graphical  visualization  of  the  object  but  not  the  layers  that  belong to
this object.

To optimize the filesize click "Purge" in the Application Menu. 
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Figure 1

2.1.10Document Properties

Via  the  command  “Document  Properties”  in  the  Application  Menu  you  can  specify  the
scaling units you want to use for your project. “Meter” is the default. You can also choose
between:

· Millimeter

· Centimeter

· Kilometer

· Inch (1 inch = 2.54 cm)

· Feet (1 foot = 12 inches = 30.48 cm)

Furthermore,  this  dialog  provides  you  with  information  on  the  DWG  version  your  current
planning is saved as.

2.1.11Settings

In the right-hand side of the Application Menu – right next to the „Exit“ button –  is  another
button  that  takes  you  to  the  Settings  dialog  box.  On  the  four  tabs   “Load”,  “Save”,
“Online” and  “Misc” you have the following configuration options:

Load Tab

· Scaling: This refers to the opening  of  geometry data  with unknown scaling.  You  can
either determine the standard scaling  unit  to  be applied  to  all  geometry  with  unknown
scaling. The other option is to have a scaling unit selection dialog box open every time
you open data with unknown scaling.

· Options:  Activation or  deactivation  of  the  automatic  restoration  of  the  view settings
when opening a file.

Save Tab

· Auto Save: Activate or deactivate the auto save function and the save interval.

· Cache: Activate or deactivate the cache for geometry data. We recommend to activate
the cache.

Online Tab

· Updates: Enable or disable the automatic check for new versions of the software. Apart



- 16 - Copyright © 1995 - 2009 EasternGraphics. All rights reserved.

form this, you can also use the manual software updates.

Miscellaneous Tab

· Language: Select the language in which you want to use the program. pCon.planner 6 is
available  in  German,  English,  French,  Italian,  Dutch,  Portuguese,  Romanian  and
Spanish.

· Directory for image storage: Select a harddisk directory where the textures (graphical
data) of a DWG are stored.
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2.2 The Ribbon

The Ribbon consists of numerous groups on five tabs and provides all important tools and
operations  you  need  for  your  planning.  In  this  chapter  you  will  learn  the  details  on  the
Ribbon.

The red line in figure 1 outlines the ribbon.

The links below figure 1 lead you to the single chapters.

Figure 1
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Contents

1.Home Tab

1.Clipboard

2.Room

3. Insert

4.Edit

2.Edit Tab

1.Tools

2.Visibility

3.Materials

3. Insert Tab

1.Room

2.Objects

3.Drawing element

4.Tools

4.Presentation Tab

1.Presentation

2.Animation

5.View Tab

1.Render

2.Extended Rendering Options

3.Camera Views

4.Viewports

6.Help Tab

1.Help

2. Info

2.2.1 Home Tab

The  Home  tab  includes  all  functions  and  tools  for  a  complete  room  and  furnishing
planning.  The  tab  contains  four  command  groups,  which  you  can  see  in  Figure  1.  Each
group will be described below. 

Figure 1
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Clipboard 

Figure 2

The pCon.planner clipboard allows you to cut, copy and paste objects.
It also enables you to create an image of the active view. To do this,
click  “Copy  Image”.  An  image  of  the  active  view  is  copied  into  the
clipboard.  Via  the  Paste  command  you  can  open  the  image  in  any
graphics software.

Room

Figure 3

This group contains all room  items  of  the  pCon.planner.  The
commands  allow  you to  draw walls,  insert  windows,  doors
and  floors,  and  arrange  adequate  illumination.  The  tools
allow for flexible modifications and as such enable accurate
and  customized  designs.  How  to  create  rooms  and  insert
windows, doors and so on is explained in detail  in  the  chapter
“Design and furnish rooms”.

Insert

Figure 4

The “Insert” group enables you to  insert
numerous  object  types  of  the  data
formats DWG and FML,  pictures,  text,
measures  or  geometric  2D  and  3D
elements.  The  chapters  “Objects”  and
“Drawing  objects”  explain  how  to  insert
elements.

Edit

Figure 5

The “Edit” group includes the dialogs for layers and properties. The latters
serves to edit object properties.

Via the layer dialog you can determine the visibility of objects by selecting
or deselecting single object layers. Please find further information about layers
and properties in the chapter "Functions”. 

2.2.2 Edit Tab

The Edit Tab allows you to modify objects as well as your entire project. With the tools and
materials  you  can  modify  the  shape  and  the  surface  of  elements.  Furthermore,  the
visibility options allow you to directly address layers in order to display or to hide them. 
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Figure 1

Tools

Figure 2

The  Tools  group involves  the  standard  edit  functions  of
the pCon.planner 6. These enable you to move objects, to
modify their size, to rotate, array, group, ungroup  and
extrude them.

The  functions  are  explained  in  the  passage  “Tools  in
chapter “Furnishing with the pCon.planner”.

Visibility

Figure 3

The  functions  of  this  group  allow  you  to  influence  the
visibility  of  objects.  You  can  display  or  hide  object
layers with the layer button and the corresponding  quick
access.  Furthermore,  there  are  three  buttons  to  hide  or
unhide selections of objects.

A click on the  icon  "Soften Edges" allows you to  make a
choice of the number of displayed edges of an objects.

Here you find detailed information about visibility.

Materials

Figure 4

The materials group contains several color and
texture tools, the  latter of  which  are  used to
adjust images that you place over the surface
of  an  object  exactly  to  the  shape  of  the
object.

The command “Fill  color”  is  used to  assign  a
certain  color  to  a  single  object.  “Dye
Selection” enables you to assign a color to a
selection of objects. 

The material picker allows you to pick a color or texture of an object and to assign it to
another object with only a mouse click. 

With  a  click  on  the  "Materials"  icon  you  can  open  an  online  catalog  with  many
selectable materials.

Please find further information about these tools in the chapter “Functions
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2.2.3 Insert Tab

The Insert tab provides all  functions regarding the  insertion  of  objects  into  your  planning.
The three groups on this tab include “Room”, “Objects” and “Drawing elements”. 

Figure 1

Room

Figure 2

This  group  contains  all  room  items  of  the
pCon.planner.  The  commands  allow  you  to
draw  walls,  insert  windows,  doors  and
floors,  and  arrange  adequate  illumination.
The tools allow for flexible modifications  and
as  such  enable  accurate  and  customized
designs.

Objects

Figure 3

The “pCon.Catalog” button opens an online client that
allows  you  to  access  numerous  online  catalogs.
There you  load  objects  directly  into  your  planning.
Apart  from  pieces  of  furniture,  you  can  download
different materials such as fabrics, metals or wood
and “pull” them onto objects.

The  button  “3D  Warehouse”  forwards  you  to  the
Google 3D Warehouse. 

Furthermore, you can insert text and pictures  or  you
can  import  different  file  formats  such  as  DWG  or
FML via the “object” button.

Drawing elements

Figure 4

The  "Drawing  elements"  group  includes  a  number  of  two-  and
three-dimensional objects, such as polyline, circle,  rectangles
or spheres. Furthermore, you will find here the measture tool and
the  annotations  tool.  Further drawing  elements  can  be  imported
from the "2D symbols" web catalog.

Here  you find  detailed information  on  how  to  create  and  modify
drawing elements.

http://pcon-catalog.com/symbols/lang/en
http://pcon-catalog.com/symbols/lang/en
http://pcon-catalog.com/symbols/lang/en
http://pcon-catalog.com/symbols/lang/en
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Tools

Figure 5

The  Tools  group involves  the  standard  edit  functions  of
the pCon.planner 6. These enable you to move objects, to
modify their size, to rotate, array, group, ungroup  and
extrude them.

The  functions  are  explained  in  the  passage  “Tools  in
chapter “Furnishing with the pCon.planner”.

 

2.2.4 Presentation Tab

The Presentation tab offers various presentation methods and an editor to generate
animations.

Figure 1

Presentation

 

Figure 2

Click the "Fullscreen" button to switch to the presentation mode. This  mode
works in full screen and allows to navigate through the planning as well as to
switch between the perspectives and render modes. 

It was designed to present finished designs or designs that are still in progress
 in a safe and professional way.

Further information  on the  presentation mode  can be found  in  the  chapter
"Presenting the planning".

Animation

Figure 3

The  Animation  group  contains  three  buttons:  "Edit",  "Play"  and
"Record".

The  "Edit"  button opens the  animation  editor  which  allows  you  to
generate animations.

The "Play" button opens a micro player to play the animation.

And the  "Record"  button  opens  a  dialog  box  which  allows  you  to
play  and  record  an  animation  and  to  change  the  animation
settings.
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Further information on the presentation mode can be found  in the
chapter "Presenting the planning"

2.2.5 View Tab

View tab

The  View  tab  (Figure  1)  provides  a  number  of  rendering  and  camera  modes,  as  well  as

workspace layout options. Also found here is the Zoom tool, which allows you to adjust the

view of your planning. 

Figure 1

Render

Figure 2

The pCon.planner allows  you to  render  and display
your drawings in  different  rendering  modes.  Each
rendering  mode  has distinct characteristics  to  suit
specific  needs.  For more  information  please  refer  to
chapter “Rendering modes”.

Extended Rendering Options

Figure 3

Click  on  the  icon highlighted  in  Figure  3  to  open
the  extended  rendering  options  dialog  box.  It
contains a Presentation tab, a Quality tab and a
Miscellaneous  tab,  all  of  which  allow  you  to
further  manipulate  the  planning.  For  more
information click here.

Camera Views
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Figure 4

The  camera  views  define  the  angle  The
Camera  group  provides  two-  and  three-
dimensional camera projection modes  for
viewing  your  planning  within  the  viewports.
Additionally  to  the  standard  camera
projection modes you can create individual
perspectives  via  the  “Camera”  button.
Detailed  descriptions  on  the  camera
projection modes are found here.

The Zoom  tool  is  also  found  in the  Camera
group.  For more  information  on  how  to  use
the Zoom tool please click here.

Viewports

Figure 5

The Viewports group offers six  workspace  layout  options.
You  can  choose  between  e.g.  a  single  workspace,  a
horizontal split or the display of four workspaces. To each
workspace  you  can  individually  assign  camera  angles  and
rendering modes. For more information please click here.
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2.2.6 Help Tab

The Help tab contains six buttons which will be briefly explained as follows.

Figure 1

Help group

Help

The Help  button  guides  you to  this  Online  help  providing comprehensive  information  on
the software and instructions on how to use it. 

The  Online  button  is  a  link  to  the  pCon.planner  homepage.  Here  you  can  find
comprehensive product information, news, updated downloads as well as a gallery.

Click the Online Videos to be directed to the download  website  of  the  pCon.planner  video
tutorials. These provide some extra help on using the software.

If you face problems with the software or have suggestions  please feel  free  to  contact
us. Just click the “Contact” button and you will be forwarded to a contact form.

Updates

Click  this  button  to  check  if  software  updates  are  available.  This  is  the  manual
alternative  to  the  automatic  update  service,  which  you  can  access  and  alter  via  the
Application Menu.

Info group

System info

Click the System Info button to open a window with information on your computer. This
provides information e.g. on your memory and processor. You can send this information to
the  EasternGraphics  Support  if  you  encounter  problems  with  the  pCon.planner  on  your
computer. This information often helps us to solve the issue faster. 
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About

Click this button to  display the pCon.planner splash-screen. This contains information on
the current version of the software and on copyright.
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2.3 The Quick Access Toolbar

The Quick Access Toolbar is located in the upper-left  corner  of  the  user  interface  next to
the  Application  Menu  button.  The  Quick  Access  Toolbar  allows  you  to  quickly  access
frequently used commands.

Figures 1 displays the Quick Access Toolbar which is framed with a red line.

Figure 1

Contents

1.Add a command

2.Hide a command

3.Remove a command

4.Move the Quick Access Toolbar
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2.3.1 Add a command

You can easily add any command from the Ribbon to the Quick Access Toolbar.

1.Move the cursor to the appropriate tab to display the command or  gallery  you  want
to add to the Quick Access Toolbar.

2.Right-click the command or gallery, then click “Add to Quick Access Toolbar” or “Add
Gallery to Quick Access Toolbar” on the shortcut menu. 

The command or the gallery is now displayed in the Quick Access Toolbar.

Note

A  gallery  is  a  collection  of  functions.  The  Room items gallery  contains  e.g.  windows,
doors, glass panels, and lighting options.

Once  added  to  the  Quick  Access Toolbar,  a gallery  is  displayed  by  an  icon  with  an
arrow pointing down.

2.3.2 Hide a command

You  can  hide  or  unhide  commands  you  have  added  to  the  Quick  Access  Toolbar  by
clicking the down arrow to the right of the toolbar. Checked commands are displayed in
the Quick Access Toolbar, unchecked commands are not.

Figure 1
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2.3.3 Remove a command

Commands  can  be  removed  from  the  Quick  Access  Toolbar  e.g.  when  not  needed  as
frequently any more. 

To do this, right-click the relevant command or gallery in the Quick Access Toolbar, then
click “Remove from Quick Access Toolbar” on the context menu. The command disappears
from the toolbar.

Note

You can remove the default commands  for  “Undo the  last  operation”,  “Redo the  last
undo  operation”  or  “Save  the  current  drawing”  from  the  Quick  Access  Toolbar.  To
recover these commands right-click the Quick Access Toolbar, then click “Reset Quick
Access Bar”.

2.3.4 Move the Quick Access Toolbar

The  default  location  of  the  Quick  Access  Toolbar  is  above  the  Ribbon  next  to  the
Application Menu button. You can also place the Quick Access Toolbar below the Ribbon.
To  move  the  Quick  Access  Toolbar,  right-click  on  any  command  on  the  Quick  Access
Toolbar or the  Ribbon and  click  “Show Quick  Access  Toolbar  Below the Ribbon”  on  the
context menu. 

Likewise you can move the Quick Access Toolbar back to its original location above  the
Ribbon via the shortcut menu.
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2.4 Work Area and Viewports

The work area of the pCon.planner (framed red) is located  below the Ribbon. This is where
you draw and furnish rooms. With the command of the viewports group located on the
view tab  you can split  the work area  into  up  to four  viewports.  Figure  1,  for  example,
shows the four viewports option. Each of the viewports can be assigned a different rendering
mode and a different camera angle. You can maximize any  viewport  by clicking  the  little
angle in the upper-right corner of the relevant viewport (Figure 1). Click the angle  again
to return to the original display of the work area.

The  viewport  with  the  red indication  of  the  camera  perspective  is  the  active  one.  All
planning  steps  you  carry  out  directly  affect  this  viewport.  With  a  click  onto  the  red
indication of the camera view you can change the current camera angle, e.g. from “top”
to “right”. 

The splitting of the work area allows to look at the planning from different angles and in
different rendering modes at the same time. 

Figure 1
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You can use the mouse or the following keyboard shortcuts to select the six commands in
the „viewports“ group.

Keyboard
Shortcut

Description Command in
the menu

Ctrl + F1 The work area switches to the „Single“ view
.  The  active  viewport  occupies  the  entire
work area. 

Ctrl + F2 Splits  the  work  area  into  two  vertical
viewports.

Ctrl + F3 Splits  the  work  area  into  two  horizontal
viewports.

Ctrl + F4 Splits the work area into four viewports.

Ctrl + F5 The  work area  switches  to  the  “Overview”
split.

Ctrl + F6 Splits the work area into „One + three“

Note

The  “+”  between  the  keys  indicates  that  both  keys  need  to  be  pressed
simultaneously to become effective.
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2.5 The Status Bar

The status bar at the bottom of the application visualizes  e.g. the loading progress  when
files are opened or imported. It also states the file name and – as seen in Figure 1 – gives
you practical hints on the different tools in the Ribbon. Additionally, you can enable the snap
mode by a click on the magnet symbol. The buttons at the right  side  start  the  Walkthrough
Interactive mode (footprint icon) and the Fullscreen mode (screen icon).

Figure 1 shows the Status Bar, framed with red lines.

Figure 1
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3 Furnishing with the pCon.planner
This chapter deals with the interior design and furnishing planning.  From scratch you will
learn how to carry out the planning, which important things you need to keep  in mind  and
how to efficiently and successfully work with the software.

The following table of contents gives you an overview of the topics covered in this chapter.

Contents

1.How to use your mouse and keyboard

1.Mouse

2.Keyboard

2.Select objects

1.Object structures

2.Options of selection

3.Tool and functions

1.Tools

2.Functions

4.Navigation in the planning

1.Zoom operations

2.PAN mode

3.Orbit mode

4.WASD navigation

5.Walkthrough interactive mode

5.Camera settings and rendering modes

1.Camera angles

2.Rendering modes

3.Adjust rendering

6.Aligning objects

1.Coordinate system and reference point

2.Aligning objects using the User Coordinate System

3.Activating and deactivating axes

4.Using axis snap

5.Using object snap

7.Create and furnish rooms

1.Walls

2.Doors, windows and wall openings

3.Floors

4.Objects
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5. Illumination

6.Drawing elements

8.Presenting the planning

1.Presentation

2.Animation

3.1 How to use your mouse and keyboard

This article is about the functionality of mouse and keyboard in the software. We
recommend reading this article before you start designing with the pCon.planner.

Contents

1.Mouse

1.Left mouse button

2.Right mouse button

3.Scroll-wheel

2.Keyboard

1.Enter values, measurements and operators

2.Keyboard shortcuts

3.1.1 Mouse

Left mouse button

Same as most software, click the left mouse button to operate commands, tools and
functions.

Right mouse button

The right mouse button serves three purposes in pCon.planner:
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1.A  single  click  of  the  right  mouse  button  in
the viewport opens the Context Menu. This
offers  you  several  actions,  depending  on
the  context  of  the  current  work  step,  for
example to align the User Coordinate System,
cancel an action, copy the object or lock an
axis. The entries of the context menu will
be  mentioned  in  many  chapters  of  this
online help.

Figure 1 displays the entries  of  the  context
menu that are available for moving a wall. 

Figure 1

2.You can customize the Quick Access Toolbar by right-clicking  the  Toolbar or  Ribbon.
For more information click here.

3.Within the viewports, a right-click will navigate you through the planning with the PAN
function  .  Just  keep  the  right  mouse  button  pressed  and  move  the  mouse.  For  more
information switch to the chapter "Navigating in the planning". 

Scroll-wheel
With  the  scroll  wheel  you  can  navigate  through  the  planning  project.  It  changes  the
perspective by either rotating around objects (Perspective view) or zooming (all views).

If your mouse has a button instead of a wheel, only the rotating function is  available  to
you. For zooming please use the Zoom tool in the Camera group on the View tab.

Note

1. If you keep the mouse motionless over an object or the planning space, tool tips
pop up giving information on the exact mouse position over the object.

2. If  your  mouse  does  not  have  a  scroll  wheel,  click  the  left  mouse  button  while
keeping  the  right  mouse  button  pressed  in  order  to  switch  to  the  orbit  mode
(swiveling movement).

3.1.2 Keyboard

Entering values, measurements and operators

When  creating  or  editing  objects  (drawing,  moving,  scaling  and  so  on),  you  can  use  the
keyboard to enter values, measurements or operators, e. g.  "+", "-", "*" and "/".
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Values

When using tools, value input fields are displayed close to the mouse pointer  (Figure  1).
You can change  the values by typing in  the numbers  with  your  keyboard.  pCon.planner
highlights the active value. In Figure 1 the upper value is active.

Press "Enter" to confirm the entry of the value. Afterwards the  next unfixed  value  will  be
highlighted and can be modified.

To switch between the values use the "Tab" key. 

Figure 1

Figure 1

Here  a  rectangle  room  is  being  created.
Right  to the mouse  pointer  you  can  see
the  values  2,9248  m and  2,0980  m.  They
indicate  the  length  and the  width  of  the
room.

When entering a value via the keyboard,
the number that is currently highlighted in
red will be changed first. With the Tab key
you can switch to the next number.

Confirm each entry of a value with "Enter".

Measurements

If you do not want to use the default unit of measurement (e. g. meter) you can enter a
new unit right after the value. The following units of measurement are possible:

Measurement Entry

Millimeter mm

Centimeter cm

Meter m

Kilometer km

Inch ''

Foot '

Angle °
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Measurements can be entered at the following positions:

· for all objects (walls, room elements, drawing elements...) right behind the values in the
value input field.

· for walls in the input fields for "Hight" and "Depth" on the Insert tab, Room group.

· for all drawn objects in the Properties dialog box right behind the values.

Operators

Another possibility to influence the measurements of an object is to use operators, e. g. "+",
"-", "*" and  "/", in combination with a value.

The  operator  always refers  to  the  currently  active  value.  For example,  entering  "+2"  in
figure 1 would increase the width of the room by 2 meters.

After entering the value you can of course enter any unit of measurement. Thus it would
be possible to make an entry like "-3,5m". 

Keyboard Shortcuts

For many tasks, the pCon.planner provides keyboard shortcuts. They are listed – in
alphabetical order – in the following tables.

Table 1: Keyboard Shortcuts for pCon.planner 6

Shortcut Description

Alt Move the wall end point when drawing a wall (context menu)

Alt + F4 Quit pCon.planner

Esc Cancel an action / quit the presentation mode

Delete Deletes the current selection of objects

F1 Open the online help

F2 Repeat using the previously used tool, or repeat inserting
room items such as door, window, floor, glass panel or
lighting 

F3 Open the pCon.catalog client

F4 Open the layer dialog box

F5 Open the properties dialog box

F7 Open the box for inserting objects

F9 Enable / disable "Walkthrough Interaction Mode"

F11 Open the software settings dialog box

G Enable / disable axis snap

H Enable / disable object snap (context menu) 

Space Move the reference point (context menu) 

Space Activate Looking around in the Walkthrough Interactive
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Mode

R, F R: Navigate upwards in the Perspective View

F: Navigate downwards in the Perspective View

S Navigate backwards in the Perspective View

Ctrl Copy selected items (context menu); Select more than one
object

Ctrl + + Zoom in on active viewport

Ctrl + - Zoom out on active viewport

Ctrl + A Select all

Ctrl + C/Ctrl + Delete Copy selected elements

Ctrl + D/Delete Delete selected elements

Ctrl + E Start the Extrude tool after previous selection of objects 

Ctrl + F1 Switch to single viewport

Ctrl + F2 Devide the work area into two horizontal viewports

Ctrl + F3 Devide the work area into two vertical work viewports

Ctrl + F4 Devide the work area into four viewports

Ctrl + F5 Devide the work area into "view"

Ctrl + F6 Devide the work area into "one + three"

Ctrl + G Group a selection

Ctrl + I Invert selection

Ctrl + L Start the Scale tool after previous selection of objects

Ctrl + Space Show full extend of the active viewport

Ctrl + M Start the Move tool after previous selection of objects

Ctrl + N Create new drawing

Ctrl + O Display the Open dialog box to load files

Ctrl + R Start the Rotate tool after previous selection of objects

Ctrl + S Save current drawing

Ctrl + U Ungroup selected items

Ctrl + Shift + C  Copy a picture of the active view

Ctrl + Shift + F1 Switch to camera view "Perspective

Ctrl + Shift + F2 Switch to camera view "Front"

Ctrl + Shift + F3 Switch to camera view "Top"

Ctrl + Shift + F4 Switch to camera view "Left"

Ctrl + Shift + F5 Switch to camera view "Right"

Ctrl + Shift + F6 Switch to camera view "Rear"

Ctrl + Shift + F7 Switch to camera view "Bottom"

Ctrl + Shift + F8 Switch to camera view "North East"



- 39 -

Ctrl + Shift + F9 Switch to camera view "North West"

Ctrl + Shift + F10 Switch to camera view "South East"

Ctrl + Shift + F11 Switch to camera view "South West"

Ctrl + Shift+ Space Show full extend of all viewports

Ctrl + Shift + S Open the Save-as dialog box

Ctrl +V/Shift + Insert Paste selection

Ctrl+ X/Shift + Delete Cut selection

Ctrl + Z Undo an action

Ctrl + Shift + Z Redo the last undo operation

Ctrl + Y Perform Array tool

Tab Move between values, that appear next to the mouse pointer
when using a tool, e. g. values for height, length, depth,
curve, or angle

Shift Lock / unlock axis (context menu)

Shift + F1 Switch active viewport to the Wireframe Mode

Shift + F2 Switch active viewport to the Hidden Lines Mode

Shift + F3 Switch active viewport to the Colored Mode

Shift + F4 Switch active viewport to the Conceptual Mode

Shift + F5 Switch active viewport to the Shaded Mode

Shift + F6 Switch active viewport to the Realistic Mode

V Rotate reference point / return to original orientation
(context menu) 

W, A, S, D (or arrow
keys)

W or down arrow: Move forward in the Perspective view
A or left arrow: Turn to the left in the Perspective view
S or up arrow: Move backwards in the Perspective view
D or right arrow: Move to the right in the Perspective view

Table 2: Keyboard Shortcuts for pCon.catalog

Shortcut Description

ALT + C or Ctrl + B Open Bookmark Manager

ALT + S Open Settings dialog box

ALT + M Go to home page

ALT + left arrow /
backspace

Go back one page

ALT + right arrow Go forward one page

ALT + Z or Ctrl + D Set bookmark

Esc Stop page loading

F6 Set input focus at address bar
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F5 / Ctrl + R Reload page

Ctrl + T Open new tab

Ctrl + P Open print dialog

Ctrl + W Close current tab (if more than one tab is displayed)

Ctrl + . Switch tab rightwards

Ctrl + , Switch tab to the left

Note

1. If two or  more keys  are  separated  by  a  plus  sign  (+),  they need to  be pressed
simultaneously to activate the shortcut.

2.You may know the WASD keys from navigation in some computer games. Alternatively
to WASD you can use the arrow keys. For more information on WASD click here.
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3.2 Select objects

Working with objects in your planning always requires to first select them.  That's
why this chapter deals with the different methods of selecting objects as well as
the object structures that are directly related to selection. 

Contents

1.Object structures

2.Methods of selecting

1.Selection by mouse click

2.Selection by keyboars shortcuts

3.Selection by selection rectangle

3.2.1 Object structures

Every  element  that  you  create  with,  or
load  into  pCon.planner,  consists  of
variable  amounts  of  edges  (lines)  and
surfaces.  The  rectangle  in  Figure  1,  for
example, has one surface  which  is  bounded
by four edges.

The  edges  are  defined  by  a  number  of
snap  points,  which  become  visible  when
moving the mouse pointer over any edge.

Snap points are found at the ends and mid
points  of  an  edge,  at  a  point  of
intersection,  but  also  all  along  an  edge
(displayed as an X in Figure 1).

These snap points  are  helpful  for  a number
of  operations.  They  are  especially
important  for  the  alignment  of  objects.
For more information clickhere.

Figure 1
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3.2.2 Methods of selecting

Objects  can  be  selected  by  clicking  or  by  dragging  selection  rectangles  around  the
objects. Both methods are explained below:

Selection by mouse click

One option for selecting objects in the pCon.planner
is  via  mouse-click.  Simply  click  the  surface  (if
applicableor the edge of an object.

If you want to select more than one object, hold
down the Ctrl key as you click  additional  objects.
With  this  method  you  can  select  any  number  of
elements  within  the  planning  project.  The
advantage of this selection method is that you can
accurately  determine  which  objects  you  want  to
select.

Figure 1 shows four rectangles, two of  which  have
been  selected  by  mouse-click  while  holding  down
the Ctrl key (highlighted in red).

Figure 1

Note

1.Selected objects are highlighted with a color, which makes them distinguishable from
unselected objects. 

2. If  you  are  working  in  the  Wireframe  mode,  there  are  no  surfaces  between  the
edges. Therefore only the edges are available for clicking.

Selection by keyboard shortcuts

You can use the keyboard shortcut "Ctrl + A" to select all objects  of a drawing. "Ctrl + I"
inverts a selection and "Esc" cancels the selection.

Selecting by selection rectangles

The second option for selecting objects is by dragging a rectangle around them. Hold the
left  mouse  button  and  move  the  mouse  pointer.  This  generates  a  red  or  green
rectangle.

The rectangle is red when you start in  the upper-left  and  drag  it  to  the  lower-right.  This
selects only objects  that  are entirely  within  the rectangle.  In  Figure  3,  therefore, only
the two objects on the top are selected. 

When you start the rectangle in the lower-right and drag  it  to  the  upper-left,  it  is  green.
This  selects  all  objects  that  are  entirely  and  partly  within  the  rectangle.  In  Figure  3,
therefore, all four objects are selected. 



- 43 -

Figure 2 Figure 3
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3.3 Tools and functions

The  pCon.planner  provides  you with  different  instruments  to  customize  your  room  and
furnishing elements according to your own plans and ideas.

The first chapter introduces the pCon.planner tools. The knowledge of their basic modes of
action will enable you to do your first experiments with the software.

The second chapter shows you which functions  can be applied  to  your  objects and  what
they are useful for.

Contents

1.Tools

1.Draw

2.Move

3.Rotate

4.Scale

5.Extrude

6.Curvature

7.Array tools

2.Functions

1.Group and ungroup objects

2.Control visibility

3.Edge softening

4.Assign colors

5.Assign and adapt materials

6.Edit properties

3.3.1 Tools

This  chapter  introduces  the  six  pCon.planner  tools  which  you need to  modify  objects.
The focus of this chapter is on basic explanations of the way these tools work to get you
started with the software as easily as possible.

For more detailed information on how to work with the tools please go to chapter “Create
and furnish rooms”.

3.3.1.1 Draw

With the  Drawing tool  you can create  walls  and  a number  of  two-dimensional (2d)  and
three-dimensional (3d) objects.

These are the basic steps for drawing:
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1. In the Ribbon (Edit or Insert tabs) click the wall icon or one of the 2d or 3d elements, e.
g. line or rectangle, to start the relevant drawing tool.

2.Move  the  mouse  pointer  into  one  of  your  viewports.  The  regular  mouse  pointer  now
changes to one of the symbols in Table 1. The coordinates for the position of the mouse
pointer as well as the position of the green, red and blue axis are displayed.

3.Click the viewport to mark the starting point of the object. Alternatively you can enter
exact values via the keyboard.

4.Move the mouse pointer across the viewport. This adjusts the size of your object in all
applicable dimensions (length, width, depth).

5.Click again to finish the drawing process. 

Along with the freehand drawing described above you can also enter precise values. This way
you can accurately assign starting point, length, width and depth of the object.

Enter the values by typing the numbers on the keyboard, and then press Enter. Press the
 Tab key to jump between the displayed values.

Table 1

Wall Rectangl
e

Polygon Line Circle Ellipse Arc Point Measurements Spere Cone

Note

1.For the objects wall, polygon, line and measurements  the  drawing  tool  will  not
be quitted right after creating the element. Thus you can continue to create further
elements right away.

2.To quit or cancel a drawing process of walls, polygons, lines or measurements use
the entries of the context menu. Press the right mouse button to open the context
menu. 
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3.3.1.2 Move

Elements within your  planning project  can  be
moved  to  be positioned  and  arranged  as  you
wish.

Figure  1  shows  the  moving  of  a  wall  (red
object).  It  also  features  a  reference  point,
the  starting point  of  the  movement,  and  the
vertical and horizontal distance of  the  current
position  of  the  mouse  pointer  to  the
reference point.

You have three options for moving  an  object,
which will be described as follows.

Figure 1

Option 1:

1.You select the object to be moved  and  click  it  again  (edge or  surface)  to  activate  the
Move tool.

2.Click on any point in the viewport and move the mouse to re-position the object in the
planning.

3.Click where you want to place the object to finish the move.

Option 2:

1.Select  the  object  to  be moved, and  then  click the Move  tool  in  the  Tools  group  (Edit
tab).

2.Click the desired position of the object to move the object.

3.Left-click to finish the move.

Option 3:

1.Click  the  edge  of  an  unselected  object  and  hold  the  left  mouse  button.  Begin  the
move.

2.Once  you have  started  the  moving, you can let  go  of  the  left  mouse  button  and  still
move the object around.

3.Click where you want to place the object to finish the move.

Note

1.Figure 1 shows the starting point of the movement, which is where the mouse pointer
was at the time of clicking to start an action.

2.Along  with  the  freehand  moving  options  as  described  above  you  can  enter  precise
values.  This  way  you can accurately  assign the  position  of  the  object.  Enter  the
values by typing the numbers on the keyboard, and then press enter. Press the tab
key to jump between the displayed values.
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3.3.1.3 Rotate

You have two options for rotating objects in the planning project.

Option 1:

1.Double-click  an  object  to  start  the
Rotate tool.

2.The  reference  point  –  surrounded  by  a
yellow  circle  –  is  located  where  you
double-clicked the object (Figure 1).

3.Click  again  to  define  the  location of  the
starting point for the rotation (Figure 1).

4.At this point you start with the rotation of
the object by moving the mouse pointer
.

5.The  number  right  next  to  the  mouse
pointer  is  the  value  of  the  rotation  in
degrees (Figure 1).

6.At the desired angle click again to finish
the rotation.

Figure 1

Option 2

1.Select the object to be rotated.

2.Click the Rotate command in the Tools group on the Edit tab.

3.Click anywhere in the planning to start the rotation tool.

4.Move the mouse pointer to the desired angle and click to determine the starting point of
the rotation.

5.Move the mouse pointer to rotate the object to the desired angle and click to finish the
rotation.

Note

Along with the freehand rotation as  described  above  you can also  enter precise  values.
This way you can accurately assign starting point and angle of the rotation.

Enter the values by typing the numbers on the keyboard, and then press enter. Press
the tab key to jump between the displayed values.

3.3.1.4 Scale

With the Scaling tool you can increase or decrease the size of the objects  in the planning.
The tool is located in the Tools group on the Edit tab.

There are two ways to scale objects. You  can either  use Scale Interactors  or  determine  a
distance to influence the dimensions of the elements. Both methods are explained below. The
third  part  of  this  article  explains  the  use  of  scale  axes.  They  help  you  to  scale  objects
proportionally or only in one dimension. 



- 48 - Copyright © 1995 - 2009 EasternGraphics. All rights reserved.

Scaling with Interactors

1.Select the object that is to be scaled.

2.Click  the  Scale  tool  in  the  Tools  group  on
the  Edit  tab.  The  corners  of  the  selected
object  appear  as  yellow  dots  (2D)  or  yellow
balls  (3D)  - so-called  Scale  Indicators  (see
Figure 1).

3.To change the size of the  object,  click  the
appropriate indicator  and  move  the mouse
pointer. 

4.Click again to finish the scaling. 

Figure 1

Figure 2  illustrates the  proportional  increase
of  a  rectangle  using  the  interactors  and  the
diagonal scale axis. (see below)

You  can  see  the  starting  point  (from  where
the  scaling starts).  In  the  catercorner  of  the
starting point you can see the reference point
(zero point).

The  two  values  next  to  the  cursor  indicate
the  current  size  of  the object  (in  relation  to
the  reference  point),  which  modify  when  you
move the mouse.

Furthermore you can see a diagonal axis which
helps  you  to  scale  the  rectangle
proportionally  and  a  red  arrow  which
indicates the direction of the scale process.

Figure 2

Scaling with distances

1.Select the objects you want to scale.

2.Click "Scale" in the Edit tab to  start the  scale  tool.  The  corners  of  the  selected  object
appear as yellow dots (2D) or yellow balls (3D) - so-called Scale Indicators (see Figure 1).

3.Click in the viewport to define the starting point of the distance that serves as basis for
the scale process.

4.Move the mouse to determine the distance and click again to set its end point.

5.Now move the mouse within the viewport to start the scale process of the object. 
If  you want to  use the  scale  axes  to  modify  the  dimensions  of  an  object  (see  bottom
article of this page), you need to move the mouse  around the distance  line between
reference  point  and  start  point.  Depending  on  the  position  of  the  cursor  an  axis  for
uniform or for unidimensional scaling will be displayed. For better distinguishing the axis for
the unidimensional scale process is always yellow.
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Figure  3  illustrates  the  increase  of  a  10  x  10  m
rectangle (dotted line) to a size of 15 x 15 m.

First  the  virtual  line  described  in  items  3  and  4
was  defined.  It  is  represented  by  the  distance
between reference point and starting point  and
is 10 m long.

Then the  mouse was moved  along  the  uniform
scale axis (yellow) up to a length of 15 m.

The  movement  of  the  axis  leads  to  the
proportional increase of the rectangle.

A  final  mouse  click would  now  confirm  the  new
size of 15 x 15 m and finish the scale process. 

Figure 3

Using scale axes

As  already  mentioned  above,  you  can  use  scale  axes  to  scale  objects.  They  help  you  to
modify the size of an element proportionally or in only one direction.

The proportional (uniform) scale axis becomes visible as soon as the cursor is moved along the
virtual line between starting and  end  point.  Figure 4  illustrates the  scaling of  a  2m x 2m
square. The upper right interactor was used as starting point. If you move the cursor along
the line between starting and reference point, the square will be scaled proportionally.

Furthermore,  there  are  a  horizontal  and  a  vertical  scale  axis.  They  become  visible
whenever you move the cursor by 0°, 90°, 180° or 270° around the starting point. 

Figures 5 shows the horizontal scale axis along which the 2 m x 2 m square is made wider
(not longer).

If you moved the mouse in the vertical direction, a vertical scale  axis would  become visible.
You could then modify the length.

Figure 4 Figure 5
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Note

1.Along with the freehand scaling described above you can also enter precise values. 

2.The context menu enables you to enlarge an object by a factor. Click "Input Factors
" in the context menu.

3.The Scale Interactors can be enabled or disabled  in the context menu.  To  disable
them click "Hide Scale Interactors" in the context menu.

4.Please click here for information on scaling walls.  

3.3.1.5 Extrude

Extrusion  turns enclosed two-dimensional
objects into three-dimensional structures.
 

You  can turn  squares  into  cubes  or  circles
into columns. 

Figure  1  shows  a  rectangle  that  was
extruded into a cuboid.

With  pCon.planner  you  can  extrude
rectangles, circles, ellipses, polygons and
polylines (interconnected lines).

Figure 1

Follow the steps below to extrude such structures:

1.Select the object you want to extrude.

2.Click the Extrude tool in the Tools group on the Edit tab.

3.Move the mouse pointer to the surface or edge of the two-dimensional object. You will
see the mouse pointer change its shape (Figure 1).

4.Click the edge or surface to start the extrusion process.

5.Move the mouse pointer to extrude the object or  enter a precise values.

6.Click to finish the extrusion or press Enter to confirm the value. 

Note

1.Once extruded, an object cannot be extruded further.

2. If  you  want  to  extrude  two-dimensional  objects  that  were  drawn  without  a
surface, or if you want to extrude polylines, you have  to  click the edges  to start
the extrusion process.
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3.3.1.6 Curvature

The  Curvature  tool  allows  to  curve  walls  or
arcs in a wall via Curve Interactors. 

This tool only applies to walls and is therefore
not found in the Tool group on the Edit tab.

Figure 1 shows a curved wall including height (H)
and radius (R).

For  more detailed  information  on  how  to  curve
walls please refer to chapter Curving walls.

Figure 1

3.3.1.7 Array tool

The Array tool allows you to copy an object or group of objects unlimited times in a drawing.
The Array tool applies to all types of objects (walls, doors, furniture...)

This tool makes it very easy for you to create window fronts or to arrange chairs in the
theater style.

The array tool is described below with an example (figures 1 to 4).

1.Select the object of which you want to create an array.

2.First define the axis  along which  you
want  to  align  the  array  of  objects
(steps 2 and 4). The axis requires two
points:

Click  "Array"  in  the  Tools  group  on
the Edit tab. Define the first point  of
the axis by mouse click on the desired
point in the viewport. 

In our example the first point coincides
with  the  upper  left  corner  of  the
object (Figure 1).

Figure 1

3. Define the second  point  of  the  axis
by  mouse  click  or  enter  the  exact
distance  and  angle.  Please  note  that
the  values  you  enter  refer  to  the
coordinate  system  in  point  1  (see
black  circle  with  highlighted  axes  in
Figure 2).

In  our  example  the  second  point  is

Figure 2
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placed  0,3  m away  from point  1.  The
angle is 0°.Click to confirm this point. 
 

4.After you defined the second point the
 origin  of  the coordinate  system  is
moved to this point.

Furthermore,  a  copy  of  the  original
object  was  created.  Its  upper  left
corner coincides with point 2.

The  current  distance  (highlighted  in
red) between the two objects is  0  m.
You can now change the distance by
entering a new value or moving the
copy manually.

We  recommend  you  enter  the
distance  between  original  object
and its copy by keyboard.

 

Figure 3

5. In  our  example  we  defined  a distance
of 0,2  m.  Now  enter  the  number  of
copies  that  are  to  be  placed  in  the
array.

Type  in  a  number  and  confirm  by
Enter. 

Figure  4  illustrates  a  completed  array
that  consists of  four  elements  with  a
distance  of  0,2  m  between  each
object.

Figure 4

3.3.2 Functions

This chapter introduces the different functions of the pCon.planner and explains how to
use them effectively.

Contents

1.Group and ungroup objects

2.Control visibility

3.Global edge softening

4.Assign colors

5.Assign and edit textures

6.Edit properties
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3.3.2.1 Group and ungroup objects

The Group and Ungroup commands are found in the  Tools  group on  the Edit  tab.  They
allow to group or ungroup several elements before further processing.

Single objects can consist of several elements. A table, for example,  may  consist  of  a table
top, some framework and several legs. The Ungroup function can break a table into its pieces
to allow adjusting each piece individually. 

Grouping all elements, on the other hand, allows to modify the table as a whole, e.g. the size
of the table.

The Group and Ungroup functions therefore are a prerequisite for processing objects at
a certain level of detail.

To group or ungroup elements follow the steps below.

1.Select the object or group of objects that are to be grouped or ungrouped.

2.Click the Group or Ungroup commands in the Tools group on the Edit tab.

3.3.2.2 Control visibility

pCon.planner 6 offers two methods to control the visibility of objects: 

1.via layers

2.via selections.

Both methods are explained below.

Layers

Layers dialog box

Similar  to  other  software,  the  two-  and  three-
dimensional data in pCon.planner is organized in
variable  numbers  of  layers  to  comply  with  the
specific needs of designing. 

Click the Layer button (group Visibility / Edit tab)
to open a dialog box with all current layers in the
planning project (Figure 1). You can decide which
layers are to be visible and which are not. 

Figure 1

Docking function
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The more complex the drawing the more often the layers dialog box is needed. It may even be
needed permanently. Therefore the Layers dialog box can be docked onto every  side of
the work area  and minimized.  Just  drag  the  dialog  box to  the  required  position. Figure  2
illustrates the Layers dialog box which is docked onto the left side of the work area.

Figure 2

Quick Access to layer control

Click the arrow below the layers button to open the Quick
Access to the layer control.

This feature enables you to  show or hide 3D-walls, lighting
elements,  cameras  as  well  as  all  objects  on  3D  and  2D
layers. You do not need to open the Layers dialog box where
you would have to select the items manually.

Figure  3  illustrates  the  currently  active  layer  (lighting  -
highlighted) and the two inactive layers.

Figure 3
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Selections

Hide Selections and Unhide 

The  Hide  Selection  command  (Visibility  group  on  Edit  tab)  hides  all  selected  objects
within  a  planning.  This  is  especially  helpful  when  you  want  to  temporarily  simplify  your
planning to get easier access to certain elements.

Click the Unhide tool to make all objects visible that you have previously hidden.

Hide Others and Unhide

The Hide Others command hides all elements that are not selected. 

Click the Unhide tool to make all objects visible that you have previously hidden.

Note

Changes  that  you  carry  out  in  your  planning  only  affect  visible  elements.  Hidden
objects  areexcluded  from  operations.  Saving  the  document,  however,  saves  all
data, including hidden objects.

3.3.2.3 Edge softening

Objects in pCon.planner 6 are constructed of edges and surfaces. You can determine the
rendering mode as well as the amount of edges to be displayed. Edges can be displayed
in all  rendering modes now, including the Concept mode, the  Shaded mode  and  the  Realistic
mode.  Further information  can be found  in the  chapter  "Show  outlines".  On  the  other  hand
you can reduce the amount of displayed edges  of all  objects of your drawing, but also of
single selected objects. This is done with the function "Soften edges".

Reducing the edges is possible in the range of 0 to 180 Degrees.  The  lower  the  value  the
more  edges  are  displayed.  At  0  Degrees  all  edges  of  the  object  are  displayed.  At  180
Degrees only the frame lines are displayed.

The  default  setting of the  frame  reduction  is  20 Degrees.  Thus,  specific  small  details  of
objects are not made irrecognizable by too many lines. 

But the degree  depends  on  your  specific  demands, the individual  use  of  the objects
and the object itself. So it is more efficient to adjust the degree of the edge softening
individual for every object.

Figure 1

To soften the edges for all objects, open the View
tab.  Click  the  small  down  arrow  in  the  Render
group (Figure 1).

 The  Rendering  dialog  box  opens.
Select  the  "Quality"  tab.  The  global
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Figure 2

edge softening is frames in red in figure
2.  You  can  enable  or  disable  the
global  edge  softening.  When  you
enable  it  you  can  set  an  angle
between  0  and  180  Degrees.  Your
setting applies to all objects  except to
those  that  you  have  already  assigned
an individual edge softening.

Figure 3

When  you  want  to  soften  the  edges  of  a  single
object,  select  the  object  and  click  "Soften edges"
on the Edit tab. (Figure 3)

Figure 4

A context menu opens. Set a soften angle  between
0 and 180 Degrees. Click "Apply" to assign the setting
 to the selected object independently from the global
edge  softening.  Click  "Reset  Softening"  to
automatically apply the global setting. 

If  you  click  "No  Softening"  the  Soften  angle  will
automatically  switch  to  0  Degrees  so  that  the
maximum amount of edges is displayed.

The following pictures demonstrate the use of several settings. They are only examples. The
number of variations is uncountable. 



- 57 -

Figure 5

Figure  5  shows  an  office  chair  in  the  Realistic  mode
without the edges displayed.

The  following  6  figures  illustrate  the  functionality  of  the
"Soften edges" function.

Please  note  that  each  setting  looks  different  with  every
object. There are no optimum values for the single purposes.
 

Figure 6 shows the same office chair in the Hidden Line mode and in three different stages of
edge softening. 

Figure 6 Figure 7 Figure 8

The  soften  angle  is
0°.

This  is  interesting  for
construction.

Figure 7  displays  the
same  chair  with  a
soften angle  of  20°.
This  is  the  default
angle.

This  setting  is
suitable  for
presentations.

In  this  case  the  soften
angle is 180 °. 

This  setting  is  applicable
for  simple  concept
studies.

The following pictures shows the same office chair in the Realistic mode with displayed edges
in three different intensities.

Figure 9 Figure 10 Figure 11

Office  chair  with
displayed  edges  and
without edge softening. 

This is primarily suitable for
construction purposes.

In  this  picture  the  soften
angle is 20 Degrees.

This  is  also  suitable  for
construction purposes

Figure 11 shows the office
chair with the max. soften
angle - 180 Degrees.

This  setting  is  very  good
for the presentation.
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Note

You may as well select several objects  at the same time  and  apply  the  same  soften
angle to the whole selection.

3.3.2.4 Assign colors

The Colors tool of pCon.planner 6 was designed for a number of different applications and can
therefore be used for various purposes.

Assign colors to single objects

Via the function "Fill Color" you can assign colors to the objects in your planning. 

To do this, follow the steps below.

1.Click the Color button (Materials group on the Edit tab) and click one of the provided
colors or define a color.

2.When you move the mouse pointer onto the work area, its shape turns into a color bucket 

, which tells you that the tool is active.

3.Click the objects of which you want to change the color.

4.To quit the color tool press the Esc key or click another tool.

The function "Fill Color" is also enabled when you select a material with the "Material
picker" in order to assign it to another object. Please read more in the chapter "Material
Picker". 

Dye selections

With the function "Dye Selection" you can assign the same color  to groups  of  objects.
This function is particularly useful when you draw floor-space plans since you do not have to
dye each object individually. 

To dye selections, follow the steps below: 

1.Select an arbitrary number of objects in your drawing.

2.Click  "Dye  Selection"  (Materials  group  on  the  Edit  tab)  and  click  one  of  the  provided
colors or define a color. 

3.The selected color will now be assigned to the selection of objects.

Preallocate colors to objects

Some objects can be  preallocated  a  color.  That  means  that  you  can  assign  a  color  to
certain objects before you draw them. This saves you time because you do not need to dye
them afterwards. This is possible for the following objects:
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· Rectangle

· Polygon

· Line

· Circle

· Arc

· Ellipse

· Cone

· Sphere

To  preallocate  a  color  to  an  object  click  the  arrow  that  is
surrounded  by  a  black  circle  on  Figure  1  (Drawing  Elements
group on the Insert tab). Then click one of the provided colors
or define a color.

Figure 1

3.3.2.5 Assign and edit textures

Contents

1.Assign textures

1.Pictures

2.Materials catalog and MATZ data

3.Material Picker

2.Edit textures

1.Textures for areas

2.Reset projection

3.Modify texture detail

4.Adjust textures to 3D objects

3.Mapping options

1.Planar mapping

2.Cylinder mapping

Assign textures

In  addition  to  colors  you  can  assign  textures  (materials)  to  the  objects.  Suitable  are
picture formats, such as PNG, JPG, BMP but also the MATZ data as it is available in pCon.
catalog.  The  latter are  a  texture  format  which  was  developed  to  "cover"  the  surface  of
objects.
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Pictures

You can assign pictures to objects by drag & drop. Just select a picture and drag it onto
the  surface  of  an  object.  You  can  use  pictures  that  you  find  on  websites  as  well  as
pictures from a local directory (folder).

Figure 1 illustrates the process of drag & drop using a locally saved picture.   

Figure 1

Materials catalog and MATZ data

pCon.plannter 6 gives you access to an  online  catalog  with   MATZ surface textures.  Click
the pCon.catalog button in the Object group on the Insert tab or the "Materials"  button in
the Materials group to open this catalog.

When pCon.catalog is open, click "More Catalogs" on the right side of  the  home page and

go  to  the  catalog  "World  of  Materials" which  provides numerous  materials  such  as  woods,
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fabrics, carpets, stone materials or metals from which you can make your choice. 

Click  your  desired  material  to  download  it  right  into  pCon.planner.  The  cursor  is  now  a
bucket icon to indicate the tool being active. You can now assign the chosen material to as
many objects as you like by clicking the relevant surfaces. The mouse pointer 

Figure  2  illustrates  the  selection  of  wooden  floor  coverings  that  can  be  assigned  to  the
rectangle by mouse click.

Figure 2
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Material Picker

The Material Picker allows you to pick any texture  in your planning and drop it on another
object. You find the Material Picker on the Edit tab in the  Materials group.  To enable  this
tool just click the icon. 

Figure 3

Figure 4 shows two chairs with different materials. Select the Material Picker, click anywhere
on the left chair and move the curser to the right chair. The curser is now a bucket. You can
now assign the color to the right chair or any other object / part of an object by mouse click.
Repeat this step as often as required.

Figure 4

Figure 5

Often objects consist of several parts. To dye  the  whole
objects  you  need  to  drop  the  material  on  each  part
individually. 

When you want to chose another texture, just click the
Material  picker  icon  again.  To quit  the  dying  operation
click the right mouse button / press Esc. / select "Cancel"
in the Context Menu.

  

Edit textures
Now that you have found a suitable texture -  a picture  or  MATZ  file  - for  an  object,  you
can  adjust  it  to  the  shape  of  the  object.  For  this  purpose  pCon.planner  provides  the
function "Edit Texture", which you can find  in the  Materials group on  the Edit  tab.  With
this function you can easily edit textures of 2D and 3D objects.

Textures for areas

A  texture  that  refers  to  an  area  of  an  object  can  be  adjusted  in  terms  of  its  size,
position, rotation and inclination.

Figure 3 shows a floor that was covered with a flagstone texture.  To edit  this  or  any other
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texture just follow these steps:

1.Click "Edit Texture"  (Edit tab, Materials group). You can see that the cursor changes its
shape.

2.Click any point of the texture. The Pins that you need to adjust the texture (see figure
3) are displayed. Click the relevant pin, keep the left mouse button pressed and move
the pin. (As soon as you move the pin you can let go of the left mouse button) 

3.Another click refixes the pin.

Figure 6

Figure 3 illustrates the three different kinds of pins. With the Context Menu entry "Unique
Pin Action" you can turn all pins into the shear / stretch  pin.  Then all  three  pins  switch
their shape to the green quadrangle and can now be used to adjust the  texture  on  basis  of
the position of each pin. 
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Check  out  which  of  the  two  methods  is  more
convenient for your work.
Figure  7  shows  one possibility  to  assign  a  tiles
texture to the room.

Figure 7

Reset Mapping

In Figure 3 you can see the actual texture framed in light  blue.  To  cover  the complete
floor pCon.planner automatically "maps" it as many times as necessary.

This "repetition" can be suspended with the entry "Reset Mapping" in the Context Menu.
The actual texture is then adjusted to the shape of the object. 

Figure  8  illustrates  the  effect  of  the  Context
Menu  entry  "Reset  Mapping"  on  the  given
example from figure 3.

Whether the entry "Reset  Mapping" is  useful  or
not  depends  on  the  shape  of  the  object.
Particularly  when  the  automatic  texture
mapping  does  not  have  the  ideal  result,  this
option  is  very  useful.  After  resetting  the
mapping  you  can  modify  the  size,  position,
rotation, inclination of the texture  as  described
in this chapter. Figure 8
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Modifying the texture 

As  you  have  already  learned  in  this  chapter,
the three pins in figure 6 are used to modify
the  size,  position,  degree  of  rotation  and
the inclination of a texture. 

Furthermore,  these  pins  can  be  moved  to
select  a  certain  part  of  the  texture  and  to
adjust it to the size of the object.

Figure 9 shows a wall paper that was assigned
to a rectangle by drag & drop.

We will  now adjust  the  texture  in such  a way
that the "dirty" edge disappears.

Figure 9

To  select a  certain part  of  a  texture  follow
these steps:

1.Start the Edit  Texture  Tool  (Edit  tab)  and
select the texture.

2.Click  the  relevant pins  and  let  go  of  the
mouse button. The  pins are now detached
from their prior position and can be moved.

3.Click  again  to  fix  the  new  position  of  the
pin.

In  Figure  10  the  blue  (move)  and  the  red
(rotate/scale)  pin  were  moved.  The  green
(shear/stretch)  pin  remains  at  its  position
because it is not needed for this operation. Figure 10

4.Now  click  the  red  pin,  keep  the  mouse
button  pressed  and  move  to  the  right  to
scale  the  texture.  (Once  you  have  started
to  move  the  pin  you  can  let  go  of  the  left
mouse button)

5.Click again  to fix the current position of the
texture.

6.Now  click  the  blue  pin  (move),  keep  the
mouse button pressed and move the pin.

7.Click again to confirm this modification.

Figure 11 shows the  result  of  all  modifications.
There are no "dirty" edges anymore.

Figure 11

Adjust textures to 3D objects

Along with two-dimensional objects you can of course use  the pins  to  adjust  textures  to
any three-dimensional object.

The procedure is  quite similar.  The  difference  is  that  the  pins  are always displayed  at
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the easiest accessible side of the object. This depends on the perspective.

The figures 12 and 13 illustrate the effect of a slight change of the perspective on the pins.
Even a slight change in the perspective makes the pins switch to another side of the object. 

Figure 12 Figure 13

Modifications that you perform  using the  pins  effect  all  relevant  sides  at  the  same  time
(not just the one that displays the pins).

Figure 11 demonstrates the effect of a non-proportional scaling on the different sides of the
cube. The pins are positioned like in figure 14.
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Figure 14

Note

The option "Reset Mapping" is also applicable (Context Menu) when you edit textures
of three-dimensional objects.

Mapping options

The mapping method is responsible for the way a texture is displayed on an object. In all
standard  cases  the  user  does  not  need  to  worry  about  the  mapping  method.  It  is  an
automated process in pCon.planner. 

But there are some cases when individual mapping can be useful. The following  passages
deal with the options of individual mapping.

Planar Mapping

Planar  texture  mapping  is  the  easiest  method.  The  selected  texture  is  mapped  onto  an
element from one direction. Examples are given in figures 6 - 11.
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Planar mapping is primarily used for two-dimensional objects. The entry "Planar Mapping"
in  the  Context  Menu  allows  you  to  apply  planar  mapping  also  to  three-dimensional
elements.

Figures 15 and 16 illustrate the characteristics of planar mapping from various directions. 

Figure 15 Figure 16

The red arrows in the pictures indicate the mapping direction. In the left picture you can
see the  automatic  mapping  as  it  is  performed by pCon.planner.  In  the  right  picture  the
projection plane  was rotated by 90°  to  the  object.  The  rotation  was  performed with  the
green pin (shear / stretch)

Cylinder Mapping

The cylinder mapping is used to adjust (calculate) textures to three-dimensional objects
 (figures 9 - 11). 

Here  the  selected  texture  is  not  mapped  onto  the  object  from  one  but  from  different
directions. The figures 17 and 18 demonstrate this difference. 

Figure 17 Figure 18

Figure  17  visualizes  the  cylinder  mapping,  whereas  figure  18  visualizes  the  planar
mapping.

In the Context Menu you find the two entries  "Planar  Mapping"  and "Cylinder Mapping"
which allow you to  switch between  both  mapping  options  and to  test  their  effect  on  the
objects. 
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3.3.2.6 Edit properties

Click  the  Properties  button  in  the  Tools
group on  the  Home tab  to  open  the  pCon.
planner Properties dialog box. 

This  dialog  box  provides  information  on
many  object  properties  and  also  allows
modifying these properties.

To  modify  object  properties  first  select  an
element or a group of elements. Then open
 open the Properties dialog box.  

Figure  1  displays  the  properties  of  a  point
light.  In  the  dialog  you  can,  for  example,
edit  the  position  of  the  element,  the  color
and the range of the light.

Figure 1
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3.4 Navigation in the planning

The navigation in pCon.panner includes  four  components,  which  –  in combination –  allow
you to look at your planning from every perspective.

You can zoom in and out on your  planning,  or  you can pan the view  into  all  directions.
The  orbit  mode  allows  to  rotate  around  one  set  point  and  WASD  navigation  allows
movements parallel to the planning level.

Contents

1.Zoom operations

1.Scroll wheel

2.Zoom menu items

2.PAN function

3.Orbit function

4.WASD navigation

3.4.1 Zoom operations

You can zoom in and out on your planning by using the scroll wheel of your mouse, with
particular menu items as well as with keyboard shortcuts.

Scroll-wheel

Turn the scroll wheel to zoom in and out on the planning. Turn the wheel “away” from you
to zoom in and “toward” you to zoom out.

Note that the zoom zooms to the current position of the mouse pointer. This allows you
to focus on specific objects.

Note

If your mouse does not have a scroll wheel you can use the  Zoom operations  in the
Camera group on the View  tab  or  the  respective keyboard  shortcuts  to  zoom in and
out on your planning.
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Zoom menu items

The  zoom  menu  items  are  located  in  the  Camera
group on the View  tab.  These  Zoom tools  not  only
allow to zoom in and out, but also to match the size
of the planning to the current size of the work area.

To  open  the  menu  click  the  arrow  below  the  zoom
button.

Altogether the zoom menu contains six items (Figure
1), which will be introduced as follows.

Figure 1

· Click Zoom In to zoom in on the planning in the active viewport.

· Click Zoom Out to zoom out on the planning in the active viewport.

· Click Zoom Rectangle if you want to zoom to a specific area of your planning. In the
relevant viewport click and drag the rectangle around this area. The selected area will be
zoomed in.

· Zoom Center works similarly to the Zoom Rectangle tool, only that rather than a rectangle,
this tool opens a square around the starting point.

· Zoom Extents shows the full extent of the active viewport.

· Similar to Zoom Extents, Zoom All Extents shows the full extent of all  viewports
simultaneously.

Note

1.Alternatively to the  zoom menu items you can use the  keyboard  shortcuts  as  to  be
seen in figure 1. The "+" means that you have to press the keys simultaneously.

2.Zoom Rectangle and Zoom Center are not available in the perspective camera view
.
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3.4.2 PAN mode

Figure 2

Panning  allows  you  to  move  your  view  of
the  planning  two-dimensionally.  You  can
pan  sideways  or  up  and  down  while
remaining  at  the  same  distance  (see  Figure
1). 

Click  and  hold  the  right  mouse  button  to
activate the panning function  and  move  the
mouse  pointer  vertically  or  horizontally.
The  mouse  pointer  changes  to  a  hand  icon
(encircled  in  Figure  1)  which  stands  for  the
pan mode.

Figure 1  shows  the  directions  of  the  panning
navigation  within  an  exemplary  planning
project.

3.4.3 Orbit mode

Figure 1

The  orbit  function  swivels  three-
dimensionally around one set point, which
can be positioned  on  any object  or  in empty
space.

1.To use the orbit mode, first change into the
 perspective  camera  position.  Move  the
cursor  to  the  position  around  which  you
want to swivel.

2.Click  and  hold  the  scroll  wheel  of  your
mouse.  In  the  active viewport,  the  mouse
pointer changes to indicate the  orbit  mode
(encircled in Figure 1). 

3.Move  the  mouse  to  swivel  around  the
fixed point. You are in the orbit mode for as
long as you hold the scroll wheel. 

If your mouse does not  have a scroll wheel
nor  a  middle  mouse  button,  follow  these
instructions:

1.Click the point  around  which  you want to
swivel.

2.Now  click  the  left  mouse  button  while
keeping the right mouse button pressed. 

3.Move  the  mouse  to  swivel  around  the
current  mouse  position.  You  are  in  the
Orbit mode for  as  long as  you keep  both
mouse buttons pressed.
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Note

The  orbit  function  applies  in  the  same  manner  if  your  mouse  has  a  middle  button
instead of scroll wheel.  

3.4.4 WASD navigation

Figure 1

With the arrows or with the "W",  "A",  "S",
"D"  keys  on  your  keyboard  you  can  move
your planning forward, backward, right or
left.  This  way  of  navigation  carries  out
movements  parallel  to  the  base  level  (see
Figure 1).

Unlike  the  orbit  function,  you  do  not
determine the starting point for the rotation.
The  current  camera  position   your  point
of view –  is  always  the  point  of  reference
for  the  WASD  or  arrow  navigation.  This
function  provides  the  most  realistic
navigation.
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3.4.5 Walkthrough Interaction Mode

pCon.planner provides a fifth camera mode - the Walkthrough Interaction Mode.

You  can switch  to  this  mode  via  the  Icon   in  the  Status  Bar  at  the  bottom  of  the
program or via the F9 key.

The Walkthrough Interaction Mode is only activated for the active view.  We recommend
to use this mode in the Perspective camera view.

3.5 Camera settings and rendering modes

This chapter introduces  the  different camera angles  and  rendering modes  of  the  pCon.
planner. A good understanding of  the  different  options  greatly  helps  to  efficiently  apply  the
software. All  corresponding commands are located in the Camera group and Render group
on the View tab. 

Contents

1.Camera angles

1.2D camera positions

2. Isometric camera positions

3.Perspective camera position

4. Individual camera views

5.Assign camera positions

2.Rendering modes

1.Wireframe

2.Hidden Line

3.Colored

4.Shaded

5.Conceptual

6.Realistic

7.Extended rendering options

3.Adjust Rendering

1.Show outlines

2.Transparent walls
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3.5.1 Camera angles

The different available options for camera positions are  located  in the  Camera  group on
the  View  tab.  You  can assign  the  way  you look  at  your  planning  to  match  your  needs  at
every  step  of  your  planning  progress.  The  currently  active  setting  for  each  viewport  is
highlighted on the Ribbon as shown in Figure 1.

This chapter introduces the different camera angles and provides you with some useful hints
on how to use them effectively. Furthermore you will learn how to assign individual settings to
each viewport.

3.5.1.1 2D camera positions

The  following  tables  with  the  pCon.planner  icons  in  the  left  column  and  corresponding
examples in the right column help you understand the specific settings.

The names  of  all  camera  positions except  the  perspective  view derive  from  their  spatial
relation to the top view. 

2D view Example
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The use of the Top and Bottom camera positions is mainly suitable for the drawing of walls
as well as for the insertion of room and furnishing items. They provide a good overview
of the planning’s layout and the distribution of  items.  You  can also  easily  specify  width  and
depth. The Bottom view is a rotation of the top view by 180° about the y-axis.

2D view Example
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2D view Example

Left, Right, Front and Behind views are useful for working on the objects located along
the relevant sides of the rooms, where you can easily change size and location of room
and furnishing items. Particularly height and distance measurements  are  easily  carried  out  in
these perspectives.

3.5.1.2 Isometric camera positions

The  following  tables  with  the  pCon.planner  icons  in  the  left  column  and  corresponding
examples in the right column help you understand the specific settings.

The names  of  all  camera  positions except  the  perspective  view derive  from  their  spatial
relation to the top view. 

Isometric view Example
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Isometric view Example

The  isometric  views  visualize  the  planning  three-dimensionally  disregarding  natural
distortion. These views therefore appear clearly arranged and allow to easily  edit  room  and
furnishing items.

3.5.1.3 Perspective camera position

The Perspective setting displays the observed objects in a realistic manner. This is
accomplished by including natural distortion. This provides you with a realistic impression
of your planning.
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Perspective view Example

Figure 1

3.5.1.4 Individual camera views

Along with the standard camera positions you can easily set up customized views and use
them in the further planning process.

Here you will learn how to set up and adjust individual camera views.

Contents

1.Set up individual camera views

1.Option 1

2.Option 2

2.Display / hide camera symbols

3.Adjust individual camera views

Set up individual camera views

There are two options how to set up customized camera views (cameras):

Option 1

· Click the button for the perspective view (Camera group on  the  View  tab)  to  switch  the
active viewport to the perspective view. 

· Navigate the planning to the desired view.

· Click the down arrow on the Camera button (Camera group on the View tab) and select
„Camera from view“. An individual camera view of the current perspective is created. 

· The blue circle that will immediately show up on your planning indicates the center of the
new camera view – the camera focus (see figure 3).

· If you now want to change the camera focus, just click the circle and move it. 
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In  the  paragraph  „Assign camera  positions“  you  will  learn  how  to  display  the  individual
camera views in the active viewport.

Option 2

· Click  the  button  for  the  perspective
view  in  the  Camera  group  on  the  View
tab, to switch the active viewport to the
perspective view. 

· Click the Camera button (Camera group
on the View tab). 

· The  cursor  now changes its  shape  to  a
camera icon. 

· Click  the  viewport  to  define  the
position  of  the  camera.  Alternatively
you  can enter  exact  measurements  and
confirm by Enter. 

· Now  define  the  direction  of  the
camera and the  angle  of  the shot.  To
do  this  move  the  mouse  over  the
viewport and click the desired position.
Alternatively  you  can  enter  exact
measurements and confirm each entry by
Enter.

Figure 1

Display / hide camera symbols

Figure 2

You  can  display  or  hide  the  symbols  for  your  customized
camera positions while working with you planning.  Displaying  the
symbols  is  necessary  if  you  want  to  make  changes  to  one  or
several of your individual views. 

To display or hide the camera symbols click the down arrow on
the Camera button (Camera group on the View tab) and select
"Show cameras" (figure 2).

The setting is active when it is highlighted. To deactivate it just click again.

Another possibility to display the camera symbols is via the layers and the layer control.

Adjust individual camera views

Your individual cameras can be adjusted with regard to their position and displayed detail.
To perform adjustments first click one of the camera symbols. A four-sided pyramid with its
vertical center line is displayed.

Figure 3 shows the origin of the camera, the camera focus and the displayed detail - marked
with red lines. 
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Figure 3

Rotate around origin and focus

To rotate individual cameras around the camera
focus just click the position interactor and  pan  it
(figure 4).

Another  mouse  click  confirms  the  new  camera
position.

This  change  is  particularly  convenient  when  you
want  to  look  at  an  object  from  several
perspectives.

Figure 4  illustrates (highlighted  in  light  green)  the
positioning  interactor,  all  possible  directions  as
well as - marked by a red circle - the fixed camera
focus.

Along  with  rotating  the  camera  around the  camera
focus  you  can  also  use  the  interactor  (see  red

Figure 4
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circle in figure 4) to rotate the camera itself.

Shift camera to another position

Along with  rotating  the  camera  around the  camera
focus and  rotating  the  camera  itself  you  can  also
shift  the  camera  and  its  focus  to  another
position. 

To do this click the camera symbol. The lines as
described  in  passage  "Adjust  customized  camera
positions" are displayed (figure 5). 

Click  one  of  the  lines  and  move  the  mouse  to
shift  the  position  of  the  camera  and  the  camera
focus.

Another  click  fixes  the  new  position.  Figure  5
illustrates  the  vertical  and  horizontal  movement  of
the camera.

Figure 5

Zoom in and out on display detail

The  display  detail  focussed  by  a  camera  can  be  changed  by  positioning  the  camera
closer or further away from the object. 

Additionally,  you  can  influence  the  size  of  the  display  detail  by  moving  the  position
interactor.  

To move the position interactor follow these steps:

1.Click the position interactor.

2.Move  the  interactor  along  the  line  of  the  camera  focus.  The  closer  you  get  to  the
focussed object the smaller the display detail. When you move away  from the  focussed
object the display detail will get wider.

3.A final mouse click fixes the size of the focussed area.
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3.5.1.5 Assign camera positions

There are 2 options to assign specific camera positions to a viewport.

Option 1

Figure 1

In  the  upper  left  corner  of  each  viewport
the  name  of  the  camera  perspective  is
displayed. In the active viewport  this  name
is highlighted in red. 

To  assign  the  active  viewport  another
camera position  just  click  the  highlighted
word  in  the  upper  left  corner  and  select
the relevant entry. (Figure 1)

The  menu  displays  the  standard  camera
perspectives  first.  Below  you  find  the
individual  perspectives. 

Option 2

Figure 2

Click  anywhere  in  the  viewport  to  which  you
want to assign a new camera perspective.

Click the arrow (figure 2, Camera group, View
tab)  to  see  all  possible  camera  positions.
The  standard  and  individual  views  will  be
displayed.  Select  the  appropriate  view  by
mouse click.  The  planning is  then  displayed  in

the chosen view. 

There  you  will  find  your  customized  camera  perspectives  listed  below  the  standard
positions. Click the desired position to assign it to the active viewport. 
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3.5.2 Rendering modes

Figure 1

In  pCon.planner  you  can  have  your  planning
displayed indifferent rendering modes. You can
choose  the  appropriate  setting  in  the  Render
group on the View tab, which assigns  the desired
 mode to the active viewport. 

The  active  rendering  mode  of  the  viewport  is
highlighted in color as can be seen in Figure 1.

Click  the  links  below  to  learn  more  about  the
characteristics of each rendering mode. 

Contents

1.Wireframe mode

2.Hidden Line mode

3.Colored mode

4.Conceptual mode

5.Shaded mode

6.Realistic mode

7.Extended rendering options

3.5.2.1 Wireframe mode

Figure 1

This  mode  displays  all  objects  of  your
planning  aswireframe  models.  This
means that only the construction lines
of  the  elements  are  displayed.  The
amount  of  construction  lines  is  different
depending on the object.

One typical  application  of  the  wireframe
mode is  when  3D  plannings  are  created
by accurately tracing 2D data.

Figure  1  shows  a  stool  in  wireframe
mode.
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3.5.2.2 Hidden line mode

Figure 1

Similar  to  wireframe,  the  construction  lines
remain  visible  in  the  Hidden  Line  mode.
However  the  surfaces  between  the  edges
are filled in white, concealing any lines behind
the  object.  Only  those  lines  facing  the
observer  are  displayed.  Plannings  in  the
Hidden  Line  mode  therefore  appear  less
complex than in the Wireframe mode.

Figure  1  shows  a  stool  in  the  Hidden  Line
mode.

3.5.2.3 Colored mode

Figure 1

Additionally to the  construction
lines  (as  known  from  the
Wireframe and  the  Hidden  Line
modes)  the  Colored  mode
shows colors  and textures  on
the  objects.  But  in  order  to
keep  the  required  system
resources  low  there  are  no
visual  effects  that  would
require  intensive  computer
calculations, such as light and
shades. 

This  mode  was  designed  for
two-dimensional  floor  space
plans. 

Figure 1 displays  a stool  in  the
Colored mode.
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3.5.2.4 Conceptual mode

Figure 1

The  Conceptual  mode  improves  the  three-
dimensional  perception  of  the  objects  by
systematic  application  of  cold  and  warm
colors as well as the use of reflections.

With computers that support OpenGL 2.1 this
mode  usually  provides  the  fastest
processing  speed  and  is  suitable  for  every
planning phase.

Figure 1 shows a stool in the Concept mode.

3.5.2.5 Shaded mode

Figure 1

In  contrast  to  the  Wireframe  and  Hidden
Line modes, the lights that you placed in the
planning are displayed and effective.  The
planning  therefore  appears  more  natural
than in the modes mentioned above.

The  illumination  model  that  is  used  in  this
mode is very simple. The objects themselves
are  illuminated  which  promotes  their
spatiality. But complex calculations, such
as  the  visualization  of  shades,  are  not
included  to  ensure  a  high  performance
and speed of this render mode.  

Figure 1 shows a stool in Shaded mode.

3.5.2.6 Realistic mode

Figure 1

The highest rendering quality for textures
and colors  of  room  elements  is  provided by
the  Realistic  mode.  The  shades  of  the
objects in your planning are  displayed  and
create the optimum of  real-life  appearance.
The Realistic mode is primarily suitable for
presentation  and  assessment  of  the
planning  in the end of  the  design  process.
For  the  planning  itself  we  recommend
other modes.

Figure  1  shows  a  stool  in  Realistic  mode.
More  examples  for  realistic  displays  can  be
accessed in our Gallery.

http://www.pcon-planner.com/en/gallery.html
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3.5.2.7 Extended rendering options

Figure 1

Click  the  icon encircled  in  Figure 1 to  access  the
extended  rendering  options.  A  dialog  box  opens,
which  offers  a  number  of  configuration  options  on
three  tabs:  Presentation,  Quality  and
Miscellaneous (Misc). 

Presentation tab

Colors

· "ISO/2D Background": Set a background color for all two-dimensional views.

· "Show  sky  environment  in  perspective  viewports":  A  sky  is  displayed  in  the  perspective
camera view in all rendering modes.

· "Perspective background": Set a background color for the perspective camera view.

Options

· "Point size": A point is very difficult to find in bigger drawings. To make this easier you can
adjust the point size in pixels (1 px - 50 px).

· "Use  quick  rendering":  Activate  this  option  if  you  want  pCon.planner  to  switch
automatically to a faster rendering modes. Especially with slow graphics cards this has
a very positive effect on the visualization speed of your drawing. 
You can configure the switching via the Options button: If you require an earlier or later
switching / returning to original rendering mode, just change  the delay time (in ms).
Depending on your graphics card the option "Use  wireframe as  lowest  reduction  level"  can
also speed up the navigation. Check this out!

Quality tab

Settings

· "Texture quality": With this option you can select a visualization quality of textures  from
"simple" to "Extra high". Please note that the texture quality may have an  influence on
the performance.

· "Shadow  quality":  With  this  option  you  can  select  the  quality  of  the  shadows  from
"Normal"  to "High".  Please  note  that  the  texture  quality  may  have  an  influence  on  the
performance.

· "Use anti-aliasing": With this option you can activate / deactivate  the anti-aliasing of the
objects. Objects appear more harmonic and smoother with the anti-aliasing activated.

· "Use  global  edge  softening":  With  this  option  you  can  enable  /  disable  the  global  edge
softening.  Edge  softening  reduces  the  number  of  displayed  lines  between  the  object
surfaces. Please find detailed information in the chapter "Edge softening". 
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Miscellaneous tab

· "Synchronize  center  of  orthographic  views":  Determine  whether  the  center  of  the  two-
dimensional views are to be synchronized. When this option is  activated,  navigation  in
the active viewport results in simultaneous navigation in all viewports.

· "Synchronize zoom of orthographic views": This option synchronizes the zoom in all two-
dimensional  views.  The  zoom  operations  are  carried  out  in  all  2D-viewports
simultaneously.

Note

The options for Synchronizing zoom or center directly affect the capacity of your
graphics card. If you notice a loss in the processing speed in the rendering processes
disable one or both of these options.

3.5.3 Adjust rendering

There are two  ways  to  adjust  the  rendering of  your  drawing  to  your  requirements.  On  the
one  hand  you can have  the  outlines  of  your  drawing  displayed  in  the  rendering  modes  "
Conceptual", "Shaded" and "Realistic" via  the  function  "Show  outlines".  On  the  other  hand
you can have walls displayed transparent via the function "Transparent walls".

Figure 1

The  two functions  are  found  in the  menu  that  you
can access via the small down arrow in the Render
group on the View tab (encircled on figure 1).

Figure  2  illustrates a planning  in  the  Realistic  mode  without  transparent  walls  and  without
displayed outlines. In figure 3, on the contrary, you can see a combination of both functions.

Figure 2 Figure 3
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Contents

1.Show outlines

2.Transparent walls

3.5.3.1 Show outlines

With the function "Show outlines" you can have the outlines of objects displayed also in the
rendering modes "Conceptual", "Shaded" and "Realistic". 

Figure 1

Navigate to  the  function  by clicking  the  small  down
arrow next to the rendering icons (encircled on  figure
1) in the Render group on the View tab.

Figure 2

In  the  menu  that  is  now
open  you  can  enable/
disable  the  function
"Show outlines"  by mouse
click.  The  tick  confirms
that  the  function  is
enabled.

Figure  3  shows  a planning in the  Realistic  mode  without outlines.  Figure  4  shows  the  same
planning but with the outlines displayed.

Figure 3 Figure 4
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3.5.3.2 Transparent walls

With  the  function  "Transparent Walls"  you can have  those walls  displayed  transparent  that
block your view inside a room or building. This will help you to  keep  a good  overview of  the
current room situation and facilitate the planning process.

Figure 1

To  get  to  the  function  "Transparent walls",  click  the
small  down  arrow  next  to  the  rendering  icons
(encircled on figure 1) in the Render group on the View
tab.

Figure 2

In  the  menu  that  is  now
open  you  can  enable/
disable  the  function
"Transparent  walls"  by
mouse  click.  The  tick
confirms  that  the  function
is enabled.

Figure  3  shows  a planning in the  Realistic  mode  without outlines.  Figure  4  shows  the  same
planning but with transparent walls.

Figure 3 Figure 4
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3.6 Aligning objects

The  exact  alignment  of  room  and  furniture items is  of  vital  importance  during  the  planning
process. pCon.planner  6  offers  you some  useful  functions  that  will  help  you to  position  the
objects perfectly.

Contents

1.Coordinate systems and reference point

1.World Coordinate System

2.User Coordinate System

3.Reference point

2.Aligning objects with the User Coordinate System

1.Aligning objects in an unrotated coordinate system

2.Aligning objects in a rotated coordinate system

3.Activating and deactivating axes

1.Using axes in 2D views

2.Using axes in 3D views

4.Using axis snap

1.Axis snap in drawing, rotation, curving and extruding

2.Axis snap in moving and scaling

3.Lock axis

4.Disable axis snap

5.Using object snap

6.Configure snapping types

1.Selecting snapping types

2.Example snapping type "Line"

3.6.1 Coordinate systems and reference point

pCon.planner allows two-dimensional as well as three-dimensional planning, which consist
of  two  or  three  coordinate  axes  respectively.  The  software  provides  a  static,  a  priori
defined standard coordinate system  (world  coordinate system  -  WCS)  as  well  as  the
option of using a user coordinate system (UCS). 

The difference between both coordinate  systems is  that  the  origin  of  the WCS  is  fixed  in
terms of position and orientation, whereas the UCS can be rotated and moved. 

The  coordinate  systems help  you position  the  objects.  The  UCS  is  particularly  useful  when
accurately aligning objects in the desired spatial relation to one another.
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World Coordinate System (WCS) 

On  every  start  of  pCon.planner  you  work  with  the  WCS  by  default.  Its  origin  and
orientation  are  static.  The  WCS gives you the  basic  orientation  of  the  viewport  and  is
important whenever you want to return from a rotated orientation to  the  default  orientation
(more information can be found below.)

The origin of the WCS is also referred to as the absolute zero in every drawing. 

User Coordinate System (UCS)
In contrast to the WCS the origin of the UCS can be set anywhere  in the drawing and  its
orientation  can  be  changed.  This  gives  you  great  flexibility  for  the  alignment  of  the
objects  in  your  drawing.  The  chapter  "Aligning  objects  using  a  User  Coordinate  System"
explains in detail how to use the UCS to align objects.

Reference Point

Figure 1

The origin of the WCS or the BCS  is  always
determined by one and the same reference
point.

Figure 1  displays  a reference  point  to  the
left of the room (in the Top view).

On  start  of  pCon.planner  the  reference
point is always located at the zero point of
the WCS.

It  can  be  moved  or  rotated  with  the
relevant  entries  in  the  Context  Menu  or  by
pressing the Spacebar on your keyboard.  

Move Reference Point

Moving the reference point is always associated with moving the origin of the UCS.

To move the reference point just move the cursor to an arbitrary place in your drawing and
press the Spacebar. Alternatively you can click "Move BCS" in the Context Menu.

Rotate Reference Point

Along with the possibility to move the BCS you can rotate it. Move the mouse to an object
that is already positioned in the desired orientation, press  "v" or press "Rotate BCS" in
the Context Menu. The orientation of the BCS will align itself to the orientation of this object.
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Reset Reference Point

You can reset the orientation as well as the origin of a BCS. 

The Context Menu entry "Set WCS direction" turns a rotated coordinate system back to the
standard orientation of the WCS. The origin of the BCS, however, remains unchanged.

Via the Context Menu entry "Set WCS origin" you move the origin of the BCS back to the
standard origin of the WCS (zero point). The orientation of the BCS, however, remains
unchanged.

3.6.2 Aligning objects using the User Coordinate System

The reference point determines, as  described  in the  previous  article  (Coordinate  systems
and reference point), the zero point of the coordinate systems. Its orientation represents
its rotation.

The two following articles describe how to align objects with the help of a reference point in a
rotated as well as an unrotated coordinate system. 

Aligning objects in an unrotated coordinate system

The first example visualizes the alignment of objects  in an unrotated coordinate system
by  moving  the  reference  point.  The  orientation  of  the  unrotated  coordinate  system
matches the orientation of the standard coordinate system.

Figures 1-7 demonstrate step-by-step the alignment of three bar stools in front of a bar.

Figure 1

· Figure  1  shows  a  bar  with  three
randomly placed bar stools.

· The task is to arrange the bar stools
evenly  in  front  of  the  bar  using  a
reference  point.  The  bar  stools  are
to  be  placed  in  equal  distance  to
each other as well as to the bar. 

· The  reference  point  is  encircled
(Figures 2-7).

· Figure  1  also  shows  the  coordinate
cross, which indicates the orientation
of the user coordinate system.

Figure 1
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Figure 2

· The  vertical  alignment  of  all  bar
stools is demonstrated first.

· Move the mouse pointer –  as  shown
in Figure 2 – to the front edge of the
left bar stool (see tooltip) and  press
the spacebar on your keyboard. 

· Alternatively  click "Move UCS" in the
 Context Menu.

· This  moves  the  reference  point  to
the  location  of  the  mouse  pointer.
The  reference  point  now  marks  the
new point of origin. Figure 2

Figure 3

· Select the middle bar stool and then
click the  front  edge  of  the  stool  in
order  to  move  it.  The  vertical
distance  to  the  reference  point  is
displayed in the green box. 

· Enter a zero  (“0”)  to  align  the  stool
with the reference point (0m) and as
such with the left bar stool.

· Alternatively move the stool with the
mouse  and  click  to  fix  it  when  the
bar stool is on the same level as the
reference point.

· Repeat  these  steps  to  align  the
right-hand  bar  stool  at  the  same
distance to the bar.

Figure 3

Figure 4

· The bar stools are now all  placed  at
the  same  distance  from  the  bar.
Next, they will be arranged in such a
way that they are assembled evenly
in front of the bar.

· Every bar stool has a length of  45.3
cm. The bar is 2.2 m long.

· The horizontal distances of the right
and left stool to the ends of the bar
are to be 10  cm.  This  adds up  to  a
distance  of  32.05  cm  between  the
bar stools.

Figure 4
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Figure 5

· Move  the  reference  point  to  the
left-hand  edge  of  the  bar  in
accordance  to  Figure  5  (move
mouse pointer to the edge and press
the spacebar).

· Click the  left  stool  on  the  left  edge
and  drag  the  stool  to  activate  the
Move  tool.  Enter  “0.1”  and  press
Enter to place the stool 10 cm away
from  the  vertical  line  through  the
reference point.

· Alternatively  place  the  stool
manually. 

Figure 5

Figure 6

· Move  the  reference  point  to  the
right-hand edge of the left bar stool.

· Then move the middle stool to make
a 32.05 cm gap between the stools.

· To  do  this  grab  the  middle  stool  on
its left-hand edge and click again to
start the Move tool. Enter “0.3205”.

· Alternatively  place  the  stool
manually.

· Follow  the  same  steps  to  align  the
right-hand  stool  in  the  same
distance to the middle stool. 

Figure 6

Figure 7

· The stools are now correctly aligned
with each other. Lastly they need to
be  placed  at  the  desired  distance
from the bar.

· Set the reference point to the edge
of the bar facing the bar stools.

· Select all stools and move the group
vertically.  After  appearance  of  the
green  box  with  the  distance
measures enter the value “0.2”.

· This  finishes  the  alignment  process
in the standard coordinate system. Figure 7
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Aligning objects in a rotated coordinate system

Apart from aligning  room  and  furnishing  items  in  the  standard  coordinate  system,  you  can
rotate the coordinate system to better suit your needs. The following sequence of pictures
(Figures 8-13) shows how to do this.

Figure 8

· Figure 8 shows a table and a bench.

· In the unrotated coordinate system,
the  objects  are  parallel  to  one
another.

· The task is to  turn  the  two objects
through  45°  anticlockwise,  then  to
center  the  bench  in  front  of  the
table and  to  add  another  bench  on
the  other  side  of  the  table,  also
centered in front of it.

· The reference points in Figures 9-13
are encircled.

Figure 8

Figure 9

· Select all objects.

· Double-click  the  selected  elements
to start the Rotate tool.

· Rotate the group of elements by 45°
anticlockwise.  The  easiest  way  to
do this is by entering the value after
starting  the  tool.  Alternatively  you
can do the Rotation manually.

· The  rotation  axes  remain  in  their
standard orientation, which you can
easily  see  at  the  cross marking  the
reference point.

Figure 9
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Figure 10

· Table and bench are now rotated by
45°.

· For  aligning  the  bench  you  first
place  the  reference  point  on  the
table edge facing  the  bench.  Move
the  mouse  pointer  over  the  edge
and  either  press  the  spacebar  or
select  “Move  UCS”  in  the  Context
Menu.

· The  result  of  this  step  is  seen  in
Figure 10.

Figure 10

Figure 11

· In order to align the bench you need
to  rotate  the  user  coordinate
system.

· Leave the mouse pointer on the mid
point  of  the  table  edge  facing  the
bench  and  press  the  "v"  key  or
select  the  Context  Menu  entry
“Rotate UCS”.

· The  bench  can be centered  to  the
table e.g. by clicking one of the mid
points  of  the  long  edges  of  the
bench,  starting  the  Move  tool  and
entering “0”. Figure 11

Figure 12

· Click and hold the bench at the  mid
point  of  the  upper  long  edge  and
start  moving  it  toward  the  table  at
a 45° angle.

· The  green  axis  appears  to  simplify
your work.

· Enter a distance of approximately 30
cm between the edges  of  the  table
and bench.

· Alternatively you can manually move
the bench.

Figure 12
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Figure 13

· Move the  mouse  pointer  to  the  mid
point  of  the  upper  table  edge  and
move  the  reference  point  by  either
pressing  the  Space  bar  or  selecting
the  relevant  entry  in  the  Context
Menu.

· Click  the  bench  on  the  edge  not
facing  the  table  and  click  again  to
start the Move tool.

· Move  the  bench  toward  the  other
side  of  the  table  and  while  moving
press the Ctrl key to create of copy
of the bench.

· Repeat  the  instructions  above  to
align  the  second  bench  with  the
table.

Figure 13

3.6.3 Selecting and deselecting axes

The  two  or  three  interaction  axes  in  the  bottom-left  corner  of  the  work  area  can  be
individually switched on and off via  mouse-click.  The  activation  and  deactivation  of  axes
gives you more options for positioning room and furnishing items in your drawing. 

When you move  the  mouse pointer  over  an  axis,  this  axis is  highlighted graphically  to
indicate which of the axes you are currently focusing on.

In Figure 1 the green axis is currently in focus. Click to deactivate (Figure 2).

Figure 1 Figure 2

Using axes in 2D Views

In all two-dimensional camera views (Top, Bottom, Left, Right, Front and Back) two
interaction axes are available. You can turn one or both axes off to serve your needs.
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Figure 3

· Figure  3  shows  a  combination  of  a  table
with two chairs in top  view.  The  chair to
the  right  of  the  table  is  being
horizontally moved closer to the table. 

· To  do  this,  the  green  axis  was  first
turned off via mouse-click. 

· Then the  reference  point  was  placed  on
the  mid point  of  the  back of  the  chair,
which  allows  to  accurately  assign  the
position  of  the  chair before  and  after  the
moving process.

· As  shown in the  red  box in  Figure  3,  the
chair  was  moved  towards  the  left  by
42.5 cm.

· In the example described above, the chair
was  moved  parallel  to  the  active  axis.
The  axis  through  the  reference  point  is
displayed during the movement.  

Using axes in 3D views

Designs in 3D are considerably more difficult than in 2D. This has to do with the fact that the
mouse only conveys two dimensions. 

For this reason you should always remember to use the axes target-oriented and to turn
them on and off to best suit your specific needs at the time. 

The sequence of pictures (Figures 4-7) demonstrates the utilization of axes in a 3D planning.
The task is to rotate a bar stool through 180° and to place it seat-first on top of the bar. 

Figure 4

· All  following  steps  are  carried
out in perspective view.

· The  three axes  are  currently
activated.

· Other  objects  near  the  bar
stool  are  hidden  for
simplification.

Figure 4
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Figure 5

· The  blue  and  red  axes  are
deactivated.

· The stool is selected,  so  that
it appears in red.

· A double-click on the bar stool
 activates  the  rotation
function.

· The  bar  stool  is  rotated
around  the  green  axis
through 180°.

Figure 5

Figure 6

· The green axis is deactivated
.

· The blue axis is activated.

· The  camera  angle  is  changed
by  approximately  90°  so  that
you  look  at  the  bar  stool  from
the right-hand side.

· The  bar  stool  is  lifted  up
along  the  blue  axis  until  the
seat  is  located  slightly  above
the top of the bar.

Figure 6

Figure 7

· The blue axis is deactivated.

· The green axis is activated.

· The  bar  stool  is  moved
toward  the  bar  until  the  back
of the stool nearly  touches the
edge of the bar.

· The bar stool is now placed up-
side-down on top of the bar.

Figure 7
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3.6.4 Using axis snap

The  concept  of  axis  snap  enables  you  to  align  objects  with  axes  directly  related  to
starting points as well as reference points. 

The snap axes are imaginary lines running horizontally and vertically through the  said  points.
When  –  during  an  editing  session  –  your  mouse  pointer  crosses  any  of  these  axes  it
becomes visible and the object you are working on automatically snaps to it.

The following article is about axis snap in  the  context  of  drawing,  rotation,  extrusion  and
curving, as well as moving and scaling. Furthermore, the deactivation of axis snap and the
locking of particular axes are discussed. 

Axis snap in drawing, rotation, curving and extrusion

Below, axis snap  is  explained  in  a  drawing  situation.  It  applies  identically  to  the  rotation,
extrusion and curving functions.

The reference point is important for axis snap. It is always placed at the start of drawing
an object. It also represents the direction of the coordinate system which is displayed in
the bottom-left corner of the viewport.

When, during a drawing process, the mouse pointer comes close to one of the snap axes,
it becomes visible and the object currently being drawn snaps to it. 

Figure 1

· Figure  1  shows  a  wall  that  is  being  drawn
horizontally from left to right. 

· To create a wall  that  is  precisely  horizontal,
it  is  drawn  close  to  the  horizontal  axis
through the  reference  point.  The  wall  snaps
to the axis and  is  therefore  precisely  aligned
with it.

Axis snap in moving and scaling

The move and scale functions allow snapping not only to reference point axes, but
additionally to axes related to starting points. 
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Figure 2

· The  starting  point  is  placed  at  the  location
where  the  editing  was  started.  This  point  is
highlighted  in  yellow  as  can  be  observed  in
Figure 2.

· In  Figure  2  the  width  of  a  rectangle  is
downscaled. The original size of the object is
marked by da

· shed lines.

· Through the movement of  the  mouse  pointer
along the axis through the starting point, the
top edge of  the  rectangle  snaps to  the  now
visible horizontal snap axis.

Note

During the scaling process you can use the two vertical axes but also a diagonal
scaling axis. Read more here.

Lock axis

Axis lock is a helpful function when the objects are to be moved, scaled or drawn along a

particular snap axis. The example below (Figure 3) further explains the Axis lock function.

Figure 3

· Figure 3 shows the moving process of the
chair on the right.

· Axis  snap  has  made  the  horizontal  axis
visible.

· If you now choose the Context Menu item
"Lock axis” (alternatively press Shift),  the
axis  is  frozen.  This  means  that  vertical
mouse  movements  do  not  cause  object
movement.

· This  gives  you  better  control  over  the
horizontal  moving  process  currently
carried out.

· Press  Shift  or  click  “Unlock  axis”  in  the
Context Menu to deactivate the lock.

Figure 3

Disable axis snap

On occasion the axis snap function may not be helpful. In this case you have the option
to turn it off.
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To  deactivate  the  axis  snap  move  the  mouse  pointer  over  an  axis  during  an  editing
session,  leave  it  until  the  Context  Menu  appears  and  click  “Disable  Axis  Snap”.
Alternatively you can press the "N" key right after snapping to an axis.

Press "N" again or click "Activate axis snap" in the Context Menu to re-activate the axis
snap.

3.6.5 Using ojects snap

Figure 1

Object  snap  is  another  instrument  for
aligning  objects.  Similar  to  axis  snap  it
provokes  snapping  to  elements.  Snap
 points  and  edges  are  important  in  this
context. 

Figure 1 shows an example for object snap: 

The  rectangle  on  the  right  has  been
moved  toward the  white  rectangle.  The
movement wasinitiated  in  the  middle of
the  right  rectangle  where  the  mouse
pointer was located at the time.

When  the  mouse  pointer  came  close  to
the  right-hand  side  edge  of  the  white
rectangle it  snapped  to it.  The  relevant
edge  of  the  white  rectangle  now  appears
as a dashed line.

Object  snap  can be  deactivated  via  the
Context Menu  (“Disable object snap”) or
via pressing the"H" key.

3.6.6 Configure snapping types

You can select  the  snapping  type  you  want  to  use.  This  can  be  of  advantage  since  the
selection of some snapping types prevents the unintentional snapping to certain objects.

Selecting a snapping type 

To select a snapping type just click the Magnet icon  on the Status bar in the bottom
right corner of the application. 

Figure 2

Figure 2 shows all snapping types. The checked  types are enabled,
the unchecked are disabled. Click "(Select All") to enable / disable all
snapping types. 
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Figure 3

Figure 3 illustrates all possible snapping types
of  a  line  that  appear  when  moving  the  cursor
over the grey line. The rectangles are  the  end
points  of  the  grey  line,  the  circle  marks  the
midpoint  of  the  grey  line  and  the  triangle
marks the intersection point of the red and the
grey  lines.  The  cross  symbolizes  that  the
snapping type "Line" is enabled.

Example: Snapping type "Line" 

As to be seen in figure 4 the snapping type "Line" is enabled. The selected armchair was
touched at its outer edge and moved towards the wall. When it comes close to the wall,
the fixed point of the armchair snaps to it. The snapping line is displayed as a dotted line. 

Figure 4

In  Figure  5  the  snapping  type  "Line"  was  disabled.  You  can  now  effortless  move  the
armchair through the wall since it does not snap to the wall. This can be of advantage if you
want to place a piece of furniture in a certain angle close to the wall without snapping to it. 



- 105 -



- 106 - Copyright © 1995 - 2009 EasternGraphics. All rights reserved.

3.7 Design and furnish rooms

This chapter is dedicated to the room and furnishing planning. In the following paragraphs
you will learn how to create rooms, how to outfit them with windows, doors, floors, lighting
and furnishing items and how you can assign materials to objects.

Contents

1.Walls

1.Drawing walls

2.Moving walls

3.Rotating walls

4.Scaling walls

5.Stretching and shortening walls

6.Curving walls

7.Extruding walls (adjusting the height)

8.Connecting, disconnecting and splitting walls

9.Grouping walls

2.Doors, windows and wall openings

1. Insertion process

2.Modifying position and size

3.Opening options for doors and windows

4.Round wall openings and niches

3.Floors

4.Objects

1.pCon.catalog client

2.3D warehouse

3. Importing file formats

4. Inserting pictures

5. Inserting texts and annotations

5. Illumination

1.Spotlight

2.Directional light

3.Point light

4.Default illumination

6.Drawing elements

1.Creating drawing elements
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2.Moving drawing elements

3.Rotating drawing elements

4.Scaling drawing elements

5.Extruding drawing elements

6.2D symbols catalog

3.7.1 Walls

The following chapter contains all important functions you need for creating and editing
the room element “wall”. 

Contents

1.Drawing walls

2.Moving walls

3.Rotating walls

4.Scaling walls

5.Stretching and shortening walls

6.Curving walls

7.Extruding walls (adjusting the height)

8.Connecting, disconnecting and splitting walls

9.Grouping walls

3.7.1.1 Drawing walls

The basis of each planning process is a room built of several walls. Along with the simple
rectangular room, which you can draw by only two mouse clicks, pCon.planner offers you
plenty of possibilities to create individual rooms. 

The  first  two  articles  are  a  quick  reference  to  create  individual  or  simple  rooms.  The
following sections explain details, such as defining angles, length and hight of walls, the
 axis snap or the use of wall starting points and wall end points.

Contents

1.Creating individual rooms

2.Creating rectangular rooms

3.Defining hight and depth

4.Defining angle and length

5.Moving wall starting point and wall end point

6.Using the axis snap

7.Properties dialog box
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Creating individual rooms

Figure 1

With the  Wall  icon  (encircled  black  in figure 1)
on  the  Insert  tab  (Room  group)  you  can  draw
single  walls,  that  form  rooms.  Follow  the  steps
below to draw a room.

1.Click the Wall icon on the Insert tab (Room group) to start the wall drawing tool.

2.Click the viewport to set the starting point of the wall.

3.Draw the walls by moving the mouse pointer into the desired direction.

4.Click or press Enter to fix the wall.

5.If you do not press "Esc" or click "Cancel"
in  the  Context  Menu,  the  drawing  tool
remains  active  and  repositions
automatically  at  the  end  of  the  recently
drawn wall. 

6.Now you can draw all walls as described in
item 3 and 4 until the room is  complete.You
just  need  to  position  the  starting  point  of
the  next  walls  right  onto  the  end  point  of
the previous one. 

Figure 2 displays a room in the top view and
illustrates the order in which the  walls  were
drawn. 

Figure 2

Drawing rectangular rooms

Figure 3

pCon.planner  makes  it  very  easy  to  draw
simple rectangular rooms. 

The  Room  menu  (Insert  tab)  contains  an
entry  for  rectangular  rooms  that  can  be
access  by  a  click  onto  the  arrow  encircled
black on figure 3. 

To draw a rectangular room follow the steps below:

1.Specify the "height" and "depth" of the wall in the Room group on the Insert tab. 

2.Select the entry "Rectangular room" in the Room group on the Insert tab. 

3.Click the viewport to set the starting point of the room.

4.Move the cursor into the desired direction to draw the room. A  final  click finishes  the
room. Alternatively you can enter exact values for the length and the width of the room.
For more information about how to use the keyboard to enter values click here.
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Defining hight and depth

Figure 4

Before you start  drawing  walls  you  should  assign  their  height
and  depth.  Enter  the  specific  values  into  the  appropriate
boxes next to the wall icon.

For  more information  on  dealing  with  different  wall  heights  in
the same room go to chapter Extruding walls.

Defining angle and length

Figure 5

During the process of  drawing walls (see  "
creating  individual  rooms")  you  can  change
the length and the angle of a wall.

The starting point  of a wall  is  at  the  same
time the  reference  point.  Depending  on  how
long  and  at  what  angle  you  draw  the  wall
(item  3  of  the  drawing  process)  it  displays
different  values  right  next  to  the  mouse
pointer. 

Figure 5 illustrates that the wall end  point is
4,0147  m  away  from  the  reference  point
(length) and has an angle of 32,5647°.

You can either change the  angle  and  length
by  moving  the  cursor  or  by  keyboard
entry. Clickenter to read more.

Notes

The reference for the angle is the horizontal axis. If the wall is drawn along this
axis the angle is 0°.
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Moving wall starting point and wall end point

Figure 6

During  step  3  of  the  drawing  process  you
can  press  the "Ctrl"  key and/or  "Alt"  to
shift  the  wall  starting  point  (reference
point) or the wall end point.

Figure 6  demonstrates  with  an  example  the
use of this feature. The walls A and B are to
be  interconnected by a third  wall  (C).  The
inside  dimension of  wall  A  (1,5  m)  and  the
outside dimension of wall B (2 m) are not to
be  changed.  To  do  this  the  wall  starting
point and  the  wall  end  point of  walls  C  are
moved in the appropriate direction.

Note

Wall starting point and wall end point derive from the snap points as described in the
chapter "Object Structures".

Using the axis snap

Figure 7

The  concept  of  axis  snap  enables  you  to
align objects  with the  help  of  snap  axes
that show up during the drawing process
. These axes represent the orientation of
the coordinate system. 

When  –  during  an  editing  session  –  the
mouse pointer crosses the reference point
 horizontally or vertically, the snap axes
become visible.

Walls  have  additional  snap  axes
between the snap points in the corners.

Figure  7  illustrates  the  process  of  drawing
the  third  wall  of  a  room.  At  the  horizontal
position of 5,3907 m the snap points of wall
1  and  wall  3  are  perfectly  opposite  each
other and thus axis 1 is displayed.

Axis snap particularly facilitates the construction of rectangular rooms. 

Properties dialog box
You  can  modify  the  hight  and  the  depth  of  a  wall  that  was  already  drawn  in  the
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Properties dialog box. Just  select  the  wall  to  be modified  and  then  click  the  Properties
button on the Home tab (Edit group). In the Properties dialog box you can enter the precise
values. 

3.7.1.2 Moving walls

Moving walls is fundamental for  modifying  the  layout  of  a room. The  pCon.planner  therefore
offers several options for moving walls. You can either use so-called  object interactors
or you can work with object surfaces, edges and snap points.

Contents

1.Moving walls without interactors

1.Option 1

2.Option 2

2.Moving walls with interactors

1.End interactors

2.Mid interactor

Moving walls without interactors

The moving of walls can be carried out with object surfaces, object edges and snap points.
The following example demonstrates two options.

Option 1

1.Select  a  wall  and  then  click  either  the
surface, edge or one of the snap points.

2.Move the wall  into  the  desired  direction.
Figure  1  shows  how  the  mouse  pointer
changed into a cross indicating the  moving
operation. The displayed values express the
vertical  and  horizontal  distance  between
the reference point and the  current  mouse
position.

3.Enter  the  relevant  values  and  then  press
Enter  to  perform  the  move.  The  tab  key
allows to jump between the two values.

Figure 1

If you decide not to work with exact values click the desired position of the wall to move it to
this location.
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Option 2

The second option for moving walls is to use the Move tool in the Tool group on the Edit tab.

1.Select the wall, then click the Move tool (Edit tab, Tools group)

2.Move the mouse pointer into the viewport. You can see the mouse pointer change into a
cross indicating the Move tool.

3.Click anywhere in the viewport. This activates the Move operation.

4.Move the mouse  pointer  to  move  the  wall  to  the  desired  location.  Alternatively  you
can enter exact the values.

Moving walls with interactors

Figure 2

The  differences  between  moving  walls  with
interactors  to  the  methods  described  above
are explained as follows.

Every  selected  wall  features  two  end-
interactors and  one  mid  interactor,  which
are pointed out in Figure 2.

End interactors allow to change the length
and angle of a wall while the opposite end-
interactor remains fixed to its location.

The  mid interactor  allows  you to  grip  and
move a wall. When you move a wall via the
mid-interactor,  the  adjacent  walls  are
automatically  adjusted.  The  room
compound is therefore obtained.

End interactors

They allow you to modify the length and the angle of a walls by moving one of the ends
while the other end remains at its position. 

1.Select a wall via mouse-click and click one of the end interactors.

2.You can now change the angle  of the wall as well as its length by simply moving your
mouse  sideways  or  up  and  down.  The  reference  point  is  automatically  placed  at  the
opposite end of the wall, the location of which remains unchanged (see Figure 3). All  values
displayed along the wall relate to the reference point.

3.Click the desired location or enter values to determine the new position of the wall.

Notes

In order to change the length of walls please also refer to the paragraph  Stretching and
shortening walls.
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Mid interactor

When  you  move  a  wall  via  the  mid  interactor,  the  adjacent  walls  are  automatically
adjusted. The room compound is therefore obtained.

1.Select a wall at the mid interactor. Note
that  the  reference  point  is  automatically
placed at the same location.

2.You can move the wall  up  and down or
sideways.  In  Figure  3,  for  example,  the
wall  was moved to the left starting  at  the
reference  point.  Both  adjacent  walls  were
shortened  accordingly.  The  room
compound was obtained.

3.A  final  click  finishes  the  movement.
Alternatively you can enter exact values.

Figure 3

Notes

1.The Move tool cannot be applied in combination with interactors.

2.The activation of axis snap allows to easily move walls along a fixed axis.

3.7.1.3 Rotating walls

The pCon.planner allows to easily and quickly rotate walls. To do this the walls need to be
selected. The rotation function will be explained in the following example. The top view will be
used to take advantage of the good general overview provided by this camera perspective. 

Starting the rotation

There are two options for starting the rotation function.

· Double-click the already selected wall.

· The Rotate tool is started at the location of the double-click.

or:

· Click the rotate tool on the Edit tab and click anywhere in the viewport. The Rotate tool is
started at the location of the click.

· Make sure that the wall that you wish to rotate is selected beforehand.
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Performing the rotation 

After starting the rotation a yellow circle (Rotate tool symbol) appears in the viewport. The
reference point is located in its center and a rotation axis points to the right to indicate a 0°
rotation. 

To  carry  out  the  rotation  you  first  have  to  click  the  viewport  again  to  determine  the
starting point of the rotation. Then  the  rotation  of  the  wall  begins.  The  rotation  can be
done manually or via entering a specific anlge. Figure 2 shows the previously horizontal wall
from Figure 1 rotated by 45°.

Figure 1 Figure 2

3.7.1.4 Scaling walls

pCon.planner features a scale tool that allows you to to modify the size of single walls but
also entire rooms. As already described in the chapter "Scale" you can perform the scaling
process with scale interactors, scale distances and scale axes.

Scaling with interactors

1.First select the wall to be scaled.

2.Then click "Scale" in the  Tools  group  on  the  Edit  tab  to  start  the scale  tool.  The  wall
now displays yellow dots (2D) or yellow balls  (3D) - so-called scale interactors.

3.Click and hold one of the interactors and move the mouse to scale the wall up or down.
 Alternatively you can enter precise values and measurements to influence the size of the
wall.

4.When the wall has reached the desired size click again or press Enter to confirm.

Scaling with distances

1.First select the wall to be scaled.

2.Then click "Scale" in the Tools group on the Edit tab to start the scale tool.

3.Click  anywhere in the  viewport  to  set  the starting  point  for  the  up-scaling  or  down-
scaling of the element.
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4.Move the mouse from the starting  point into  the desired  direction  and  click  again  at
the desired distance.

5.Now move the mouse over the viewport to start scaling the wall. 

6.At the desired size click again to finish the scaling process.

Alternatively you can enter precise values and measurements during steps 4 - 6.

Using scale axes

Scaling axes help you scale walls proportionally or one-dimensionally. 

The  proportional  (uniform) scale  axis  becomes visible  as  soon as  the  cursor  is  moved
along the virtual line between starting point and end point. 

Figure  1  illustrates  the  proportional  scaling  of  a  wall.  The  original  size  of  the  wall  is
displayed with a blue dashed line. The wall was scaled with the help of a scale distance. 

The one-dimensional scale axes become  visible  whenever  the  cursor  crosses a  point  in
the coordinate system that forms a horizontal or vertical line with the start point of the
scaling. 

Figure 2 illustrates one-dimensional scaling of a wall along the vertical (green) scale axis.

Figure 1 Figure 2

3.7.1.5 Stretching and shortening walls

The length of walls can be changed via move operations as well as scaling. Another option
changes the length through determining directional interactors  (Figure  1)  and  entering
values.

Follow the steps below:

· Select a single wall.
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· Click  the  directional  interactor  (Figure  1)  to  determine  the  direction  of  the  change  in
length.

· Click one of the length values (Figure 2) of the wall and enter a value. Of course you can
also enter a factor, e.g. "*2" .

· Press Enter to confirm.

Figure 1 Figure 2

Note

A change  in  length  of  one  single  wall  using the  method described  above  alters  the
proportions of the entire room.

3.7.1.6 Curving walls

Rooms are often not  entirely  perpendicular  but  instead  are  curved  in  some  way  or  other.
pCon.planner therefore provides options for curving walls to better allow your planning to  be
adjusted to reality.

Figures 1-4 and the associated explanations demonstrate the curving of walls.

Figure 1

· The  curving  function  is  carried  out
using curvature interactors.

· These become visible when a wall is
selected.

· Every  wall  has  two  of  these
interactors.

Figure 1
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Figure 2

· To  curve  a  wall  click  one  of  the
interactors  and  move  the  mouse
pointer.

· The green box displays the distance
between the mid point of the wall to
the  reference  point  (encircled  in
Figure 2).

· This value is called the height (H).

Figure 2

Figure 3

· You  can  manually  curve  a  wall.
Simply click to finish the operation
when  the  wall  has  reached  the
desired curvature.

Or:

· Enter  the  exact  height  of  the
desired curvature and press Enter.

Figure 3

Figure 4

· The  curvature  of  a  wall  is  never
definite. Changes can be carried
out  via  curvature  interactors,
end-interactors  or  via  height
and radius. 

· Figure  4  demonstrates  the  use  of
the  right  end  interactor  to  modify
the curvature.

· The  value  input  field  right  next  to
the  mouse  pointer  displays  the
distance  and  the  angle  to  the
reference point (encircled black).

Figure 4
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3.7.1.7 Extruding walls (adjusting the height)

In the context of walls, extrusion refers to the modification of their height. The  drawing
process allocates an identical height to all  walls. Through extrusion you can assign differing
heights or even sloping walls. 

Before you use the function you should choose a  suitable  camera view.  Most  of  the  time,
the side perspectives such as Front, Behind, Left of Right will be the most suitable views.

Figures 1-3 demonstrate the extrusion function.

Figure 1

· Every  wall  has  three  Extrusion
interactors (see Figure 1).

· The  two  end-interactors  allow  you  to
create slopes.

· The  interactor in  the middle  allows  you
to change the overall height of the wall.

Figure 1

Figure 2

· Click the appropriate interactor to start
the Extrude tool.

· Now  you  can  adjust  the  height  by
moving the mouse pointer (Figure 2).

· You can also  enter the  associated  height
into the blue box.

Figure 2



- 119 -

Figure 3

· To  create  a  sloping  wall,  just  change
the hight or the angle of ONE of the end
interactors.  Click  the  relevant  values
above the  extrusion interactors  and  enter
the numbers, then press Enter.

· On  Figure  3  you  can  see  a  wall  with  a
sloping  ceiling.  The  height  of  the  wall
varies  by  1  m  along  the  entire  length  of
the  wall.  At  a  wall  length  of  4.5  meters
this adds up to a 12.5° angle.

Figure 3

Note

You can assign negative angles by entering a minus (-) in front of the number.

3.7.1.8 Connecting, disconnecting and splitting walls

The pCon.planner provides three special tools for assembling walls. They can be accessed
via the wall icon in the Room group on the Insert tab. The three functions will be described
as follows.

Connecting and disconnecting walls

Via the  Connect  function  you can  attach  walls  to  one  another.  A  typical  application  is
when  two  single  walls  meet  and  are  to  be  connected  to  each  other  (Figure  1).  The
connection function removes any gap between them. 

Select  the  relevant  walls  and  click  “Connect”.  Figure  2  shows  how the  connection  made
both walls slightly longer.

Figure 1 Figure 2
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The Disconnect function dissolves existing connections. Select the walls which are to be
disconnected and click “Disconnect”.

Note

The Connect function allows you to connect any number of walls. The only requirement
is that they intersect.

Splitting walls

The Split function allows you to split walls to enable working on its pieces independently.

For splitting walls follow the instructions below:

· Select the wall which is to be split.

· Click the arrow below the wall icon (Room group, Insert tab) and click Split.

· The reference point is automatically placed at the mid point of the wall (encircled in Figure
3). This ensures that you can precisely halve the wall, although you can choose any point
along the wall for splitting.

· Click at  the  desired  location  on  the  wall  to  set  the splitting  point  or enter the  exact
value and press Enter.

· The wall has now been split. In Figure 4 you can see that the horizontal wall is now made
up of two equal parts. Each part has a length of 1 m.

Figure 3 Figure 4

3.7.1.9 Grouping walls

Oftentimes it is more efficient to work on several walls of a room, or an entire  room, at
the  same time  rather  than  modifying  each  wall  separately.  In  this  context,  pCon.planner
provides you with the Group Objects function.
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Follow the steps below:

· Click the relevant walls while pressing the Ctrl key to select all  walls that  you want to
group.

· Click the Group tool in the Tools group on the Edit tab.

· The  walls  are  now connected to  a group.  Editing  functions  such  as  moving  or  rotation
now apply to the entire group.

Object groups can be dissolved via the “Ungroup” operation. Select the group and click
“Ungroup” in the Tool group on the Edit tab.

3.7.2 Doors, windows and wall openings

This  chapter  deals  with  room  elements  that  structure  walls:  doors,  windows  (double
windows), glass  panels  (glass fronts)  and  wall  openings.  By  means  of  a  building  section
(Figures 1 and 2) we will explain how to insert such room elements, how to adjust their
size and position, and how to assign specific opening properties. 

Step by step the two adjacent rooms in figures 1 and 2 will be fitted with a number of room
items which will then be adjusted according to given instructions. Figure 1 shows the intended
purposes of both rooms (office and hallway).

Figure 1 Figure 2

Contents

1. Insertion process

2.Modifying position and size

3.Opening options for doors and windows
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3.7.2.1 Insertion process

The  building  section  at  hand  is  to  be  fitted  with  several  room  elements.  Four  specific
modifications are to be carried out:

· Insertion of a door into the wall between office and hallway.

· Insertion of three simple windows into the right exterior wall.

· Insertion of a glass panel into the left exterior wall.

· An opening between the hallway and the adjacent building at the bottom wall.

Note

Doors,  windows  and  openings  can  only  be  inserted  into  existing  walls.  A  position
outside of walls is not possible.

We  recommend  you to  insert  room  elements  in  the  top  view  and  the  Wireframe  rendering
mode. This gives you a good overview of the room and you can observe many object details.

There are three steps to the insertion process:

· Select a room element in the Room group on the Insert tab.

· Move the mouse pointer to a wall in the planning.

· Click anywhere on the wall to insert the object.

Step  by step  you  can  now  insert  any  number  of  room  elements  following  the  method
above.  The  result  of  this  process  can  be  seen  two-dimensionally  in  Figure  1  and  three-
dimensionally in Figure 2.

Figure 1 Figure 2

The insertion of several items of the same type can be achieved as follows:
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Either:

· Press and hold the Shift key when  clicking the room  element  in  the  selection  on  the
Insert tab. Now insert as many items of this type (Step 3) as are needed. To finish the
operation press Esc or click Cancel in the  Context Menuto cancel the operation.

Or:

· After Step 3 press F2 to insert another identical element. Press F2 again to repeat
inserting.

Note

Next  to  the  entry  "Glass  panel"  there  is  the  entry  "Glass  front"  which  is  a
combination of several glass panels. 

After  selecting  the  room  element  "Glass  front"  you  determine  the  starting  and  end
point  of  it  by  mouse  click.  The  distance  between  both  points  will  be  fitted
automatically with the appropriate number of glass panels.

3.7.2.2 Modifying position and size

The height, width and position of room elements (doors, windows, glass panels or
openings) can be changed, and that both manually and by entering values. The
adjustment of size and position will be demonstrated in the given example.

Contents

1.Modifying the size

1.Manual modification

2.Entering values

2.Modifying the position

1.Manual modification

2.Entering values

Modifying the size

The  size  of  doors,  windows,  glass  panels  and  wall  openings  can  be  modified  by
entering values or manually via certain interactors.

Manual modification

The manual way of modifying the size of room elements is carried out via the interactors as
to be seen in figures 1 and 2.

Click the relevant interactors for the height or width and drag them until the object has
the desired size. Click again to finish the operation.
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Figure 1 Figure 2

Note

Use the buttons “Hide selection” and “Hide others” on the Edit tab (Visibility group)
to temporarily hide concealing objects.

Not all camera perspectives allow you to modify widths or heights. Left, Right, Front and
Rear  camera  views  only  support  height  modifications,  while  Top  and  Bottom  views
only allow modifications of width. Depending on the perspective, three-dimensional
views allow modifications of both.

Modifying the size by entering values

The other way of manipulating height and width of objects is  to  enter  specific  values.  In
Figure 3 you can see one detail of the example room rotated left by 90°. When you select a
room element, quite a few numbers appear (see Figure  3). Each  number  indicates  a specific
dimension of the selected object (see legend). Always take good care as to what number
to modify. Figure 3 shows different dimensions that appear after selection of a door.

Figure 3

Legend

1.Distance from outer edge of the door to the
wall.

2.Width of the door.

3. Interactor: vertical opening properties.

4. Interactor: horizontal opening properties.

In  order  to  modify  the  size,  first  choose  a  suitable  camera  perspective.  Then  click  the
relevant number and enter the desired value, then click Enter. In the example room, the
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room elements are to be attributed with the following values: 

· Door: height: 2.2 meters; width: 1.0 meters

· Window: height: 1.4 meters; width: 0.9 meters

· Glass panel: height: 2.5 meters; width: 4.5 meters

· Opening: height: 2.4 meters; width: 3.0 meters

The resulting sizes can be seen as two- and three-dimensional views in Figure 4 and 5. 

Do not worry about  the  position  of  some  of  the  room  elements  just  yet.  So far no  specific
instructions have been given. The next two paragraphs will continue with this.

Figure 4 Figure 5

Modifying the position 

The  position  of  room  elements  can  be  modified  either  manually  or  by  value  entry.  The
following two articles explain both options.

Manual modification 

Doors, windows and wall openings can be moved manually by clicking and dragging them
to  a new position. Click  on  surfaces,  edges,  snap  points  (Figure  6),  or  mid-interactors
(Figure 7).

· Select an object.

· Click the surface, edge or mid-interactor of the object. This starts the Move mode.

· Move the mouse pointer to move the object.

· Click the desired position to finish the move operation.
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Figure 6 Figure 7

Note

1.Room elements  are  always  bound  to  an  existing  wall.  During  a  moving  operation
they can be moved across the room (except when you use the  mid-interactor),  but  it
snaps to the nearest wall as soon as you click to finish the moving operation.

2.During a moving  operation  you can  deactivate  axis  and/or  object  snap  via  the
Context Menu or keyboard shortcuts.

3.Figure 6 only shows a random selection of snap points for simplification.

Modifying the position by entering values

Room elements can be repositioned by entering specific values and measurements.
Figures 8 and 9 demonstrate which values you can change (in this case a window).

Figure 8 Figure 9

As  you can see  from the  window  example,  the  current  distance  to  the  floor  is  0.8  meters
(Figure 8). The distances to the left and right window are not identical (Figure 9). As already
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mentioned  in  the  paragraph  on  the  change  of  size,  the  view  of  certain  values  and  the
possibility to change them is dependent on the camera angle.

In order to move objects, first select the desired element. Click the distance measure
you want to change. Enter the value and press Enter. Of course you can also  work  with
measurements and operators.

Next, the room elements in the example are to be positioned as follows:

· Door:  distance  to  the  floor:  0  m;
distance to the walls (left and right):
1.75 m

· Window:  distance  to  the  floor:  0.9
m; distance to walls/windows: 0.45 m

· Glass  panel:  distance  to  floor:  0.05
m; distance to walls: 0 m

· Opening:  distance  to  floor:  0  m;
distance to walls (left and right): 0 m

Figure 10

If you have repositioned all room elements in the example your room should look similar to the
one in Figure 10. 

3.7.2.3 Opening options for doors and windows

The way doors and windows open both vertically and horizontally can be determined
via two interactors. These are highlighted in Figure 1.

Figure 1

The  vertical  opening  interactor
determines  whether  the  window  swings in
or out.

In Figure 1,  for  example,  the  window  is  set
to swing inwards into the office.

The  horizontal  opening  interactor
determines,  whether  the  room  element  is
hinged on the right or left side. 

Looking  from  inside  the  office,  the  door  in
Figure 1 is hinged on the right and therefore
opened on the left.

These opening  properties  of  a door  or  window  can  be easily  changed.  Simply  click  the
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relevant interactor (double arrow). When the mouse pointer moves over an arrow, it is
highlighted to indicate activation.
 

Figure 2

Next, the windows and doors in the example
room are  to  be  adjusted  according  to  the
following specifications:

· Door: vertically:  from the  hallway  to  the
office;  horizontally:  door  handle  on  the
left when seen from the office

· Window:  vertically:  from  outside  to  the
hallway;  horizontally:  window  handle  on
the right when seen from the hallway.

Figure 2 complies to these specifications.. 

3.7.2.4 Round wall openings and niches

The possibility to round off  wall  openings  or  turn  an  opening into a niche  opens up  a great
range of new planning variations. 

The basis of both is a standard opening in the wall.  You  find  the  room  element "Opening"  in
the Room group on the Home tab and the Insert tab.

Contents

1.Properties dialog and selection of openings

2.Round openings

3.Niches

4.Combination of round opening and niche
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Properties dialog and selection of openings

Figure 1

Figure  1  illustrates how  you  can  select  an
opening  in  all  rendering  modes.  In  this
example  shows  the  Realistic  mode.  First
select  the  wall  that  features  the  opening
and  then  select  the  opening  itself.  Then
click "Properties" in the Edit group on the
Home tab.

Figure 2

Figure  2  shows  the  Properties  dialog  box  for
the  opening of  figure  1.  This  dialog  displays
from top to bottom:

· the  name  of  the  layer  the  opening  is
assigned to, 

· the  position  of  the  opening  on  the  X,  Y
and Z axis,  which  allow  you  to  move  the
opening within the wall, 

· the  Arch  Rise  and  the  Center  Offset,
which are needed to round  off  the  opening
or to turn it into a niche.

Round openings

Figure 3

To  round  off  an  opening  you  just  enter  a
value  for  the  "Arch  Rise"  in  the  Properties
dialog. The minimum value is 0.000 m for a
rectangular  opening.  The  maximum  value
is half the width of the opening. In the case
the arch of the opening is a semi circle. 

Figure  3  illustrates  a  round  opening  with  a
width of 0.8000 m and an arch rise of 0.3000
m (half the width).

The arch can be modified at  any time. You
just  need to  enter  another  value  or  0.000
to remove it completely.
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Niches 

Figure 4

To  create  a  niche  you  need  to  enter  a
value  for  the  "Center  Offset"  in  the
Properties dialog. If you enter  0.100 m,  the
wall behind the niche will be 0.100 m deep.
Theoretically  the  Center  Offset  cannot  be
bigger than the depth of the wall. 

If  you enter  a positive  value,  the  niche  is
on  the  inner  side  of  the  wall.  Negative
values  produce  a niche  on  the  outside  of
the wall. 

Figure 4 shows  a niche  with  a Center  Offset
of 0.001 m. 

The  niche  can be removed  or modified at
any  time  by  entering  another  value  or
0.000 m.

Combination of round opening and niche

Figure 5

Round openings and niches  can of  course  be
combined. A sensible variation of niches and
openings with and without arch will make your
drawing more interesting and allows  you to
design  even  rooms  for  example  in  the
Mediterranean style. 

Figure  5  illustrates  the  combination  of  the
arch of figure 3 and the niche of figure 4. 

You can now very easily place objects, e. g.
shelves, vases, candles or accessories into  a
 niche or opening (Figure 6).
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Figure 6

3.7.3 Floors

After completing a room you can add a floor. Click “Floor” in the Room group on the Insert
tab. Then move the mouse pointer to the room you want to fit with a floor.

If the room is suitable for adding a floor, the room appears encircled by a red line (Figure 1).
Click to insert the floor. Figure 2 shows what a finished room may look like.

Figure 1 Figure 2
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Note

Floors  can  only  be  inserted  into  rooms  that  are  surrounded  by  connected  walls.
Their height is not relevant for inserting floors. 

3.7.4 Objects

In  this  chapter  you  learn  how  to  insert  objects  of  different  file  formats.  The  most
important sources for objects are the pCon.catalog-Client and the 3D-Gallery. 

Contents

1.pCon.catalog-Client

2.3D Warehouse

3. Importing file formats

4. Inserting pictures

5. Inserting texts and annotations

3.7.4.1 pCon.catalog client

Via  a  click  on  the  pCon.catalog  button  (Home  tab,  Insert  group  or  Insert  tab,  Objects
group) you open the pCon.catalog client.

The pCon.catalog client provides access to all available online catalogs  and their room
and  furnishing  objects  which  you can download  -  for  example  as  DWG  file  -  into  your
planning.

 

In the online catalogs that are accessible in pCon.catalog you will find: 

· Furniture for private and work environments, such as tables, chairs, shelves, partition walls
or shutters

· Materials  that  can be assigned  to  the  surface  of  the  objects,  such  as  woods,  plastics,
stone materials, metals, fabrics or wallpapers

· Accessories for offices and private environments, such as mirrors, plants, flipcharts, books
or dishes

· Illumination devices such as ceiling lamps, floor lamps or desk lamps

· Technical devices such as computers, hifi-equipment, TV sets or household appliances.
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Contents

1.pCon.catalog homepage

2.Navigation

1.Application menu

2.Tab bar

3.Address bar

3.Bookmarks

1.Create bookmarks

2.Manage bookmarks

3. Import / export bookmarks

4.Use bookmarks

4.Settings dialog box

1.Content and privacy

2.Login manager

5.Downloading objects

6.Behaviour of the pCon.catalog window

pCon.catalog homepage

Click  the  Catalog  button  to  open  the  Online-Catalog  client.  There  you can  search  the
appropriate objects via the search function. Furthermore, you find at the start page a list of
the latest catalogs as well as selected products.

The top menu of the pCon.catalog window provides the following functions:

· "Catalogs":  see  all  available  catalogs  and  download  products  and  materials  to  pCon.
planner

· "About": detailed introduction of pCon.catalog 

· "Try now": create an own free test catalog

· "Login": login to your test catalog

Services,  such  as  Social  Bookmarks  (at  the  bottom  of  the  window)  allow  you  to  easily
share pCon.catalog with others.
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Figure 1

Navigation

Figure 2 illustrates the different features of the navigation in the pCon.catalog client.
Some elements will be explained in detail further down in the chapter.
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Figure 2

Application menu

Figure 3

Via  the  Application  menu  of  the  pCon.catalog
client you can adjust the program functions to
your needs.

There you find:

· a link that opens the start page of the client.

· the  possibility  to  create  and  close  tabs  to
which you can assign  certain contents (pages)
and switch between them.

· the  Bookmark  Manager.  This  feature  helps
you  save,  organize  and  your  individual
bookmarks  and  to  open  a  bookmarked  page.
Read more in article on bookmarks.

· the Print preview  of  the  current  catalog  page
and the  possibility  to  print  the  current  catalog
page.

· the Settings dialog box. Here you can change
the  settings  that  concern  the  contents  and
privacy.

Tab bar

The tab bar (figure 4) allows you to  open  several pages  of  the  catalog  in parallel  within
the pCon.catalog window. Each page is loaded in a separate tab. If only one catalog page
is loaded the tab bar is not visible. It you add a new tab via the menu entry "Add tab sheet"
or Ctrl + T, the tab bar appears.

Via the tab bar you can add new tab sheets, close a tab sheet and activate selected tabs.
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Figure 4

If you want to open a link from the address bar in a  tab,  click  and hold  the  small  icon
(Fav-icon)  right  left  to  the  address bar  and  drag  the  link  onto  a  tab  or  onto  an  empty
space on the tab bar (drag & drop) to load the page there. 

The  same  applies  to  the  bookmarks  in  the  Quick  Access  Toolbar.  A  click  with  the  middle
mouse button onto a bookmark open it in a new tab.

Note

In  the  Content  tab of the  Settings  dialog (figure  3)  you  can  specify  whether  every
catalog is opened in a new tab sheet and of the tab bar is always displayed (no matter if
you use one or more tabs - figure 8)

Address bar

The Address bar is used to enter the URLs of the catalogs (figure 5).

Figure 5

The address history displays the catalog pages you have already visited (figure 6). The
auto completion of you entry helps you to  find  pages  that  you have  already  visited  again
quickly. Click the small arrow right to the address bar to drop down the history.

Figure 6

Bookmarks

Bookmarks are used to faster access pages that are often needed. You probably know the
bookmarks concept from your Internet-Browser. 

In the pCon.catalog client you can open the pages that you often use via bookmark. 
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Create bookmarks

If  you want to  create a  bookmark  of  the  current  page,  click  the  "Star"  button  in  the
upper right corner of the pCon.catalog client (Figure 2).

Insert  a  name  for  the  bookmarked  page  and  decide  about  its  location.  You  can  either
position it in the Quick Access Toolbar (Figure 2) or in the "local bookmarks" folder.

Manage bookmarks

Figure 7

The  Bookmark  Manager  allows  you  to
manage  your  bookmarks.  You  can
access this dialog by: 

· pressing Alt + C

or via:

· Application menu / Manage bookmarks
(Figure 7).

On the  left side of  the  dialog  you  find
the  main  categories  "Quick  Access
Toolbar"  and  "Local  bookmarks"  as
well as their substructure.

When you select a folder (Figure 4)  its
content is displayed on the right side
of the dialog.

You have the following options:

· Delete: delete a selected bookmark 

· Properties: modify the title and the address of the bookmark

· Add: add a bookmark, a folder or a parting line in the Bookmark Manager. A parting line
improves the visual overview. With folders you can assign your bookmarks to individual
categories. To shift a bookmark into a folder or before/after another bookmark left-click
the bookmark and drag it to its new position.

· Import/Export: this feature is explained in the article below.

You can also use the Quick Access Toolbar to edit your bookmarks. Right-click the
bookmark to open the Context Menu. This menu allows you to 
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· open the bookmark (in a new tab sheet)

· edit the properties of the bookmark

· delete the bookmark.

To shift the bookmark to another position just move the bookmark to its new position via drag
& drop.

Note

The  two  directories  "Quick  access  toolbar"  and  "Local  bookmarks"  are  main
categories.  Thus  you cannot  create new folders  neither  above  them nor  at  the
same level. 

Import / export bookmarks

The Bookmark Manager allows you to export your bookmarks and to import them in a
pCon.planner 6 on another system or in pCon.catalog in AutoCAD. Click "Import / Export"
in the Bookmark Manager (Figure 7).

Use bookmarks

To access a bookmarked page open the Application Menu (Application menu / Bookmarks
/ Local bookmarks or Quick Access Toolbar) or use the Quick Access Toolbar (if  the Toolbar
is not displayed, click Application menu / Bookmarks / Show Quick Access Toolbar).

Then click onto the desired bookmark. 

Settings dialog box

The Settings Dialog Box consists of two tabs: "Content" and "Privacy" as shown on figures
8 and 9.
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Figure 8

Figure 9
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Content and Privacy

Click the Content tab of the Settings dialog box to make the following settings:

· define the start page of the pCon.catalog client, 

· determine whether every catalog is to be opened in a new tab sheet

· determine whether the tab bar is to be displayed even when you are working with only
one tab. 

The  Privacy tab  allows  you to  change  the  settings  of  the  Login  Manager,  the  History
Manager and the options to clear the cache. You can:

· save login data for a password protected catalog and determine whether you want to be
logged in with these data automatically.

· clear the history of visited catalogs and define for how many days the history is to be
kept.

The  cache  contains  information  on  the  objects you have  already  downloaded  and  is  useful
when you often load the same objects into your planning. The process of loading the objects
is much faster.



- 141 -

Login-Manager

The pCon.catalog client gives you access not only to free but also to password protected
catalogs.  To  open  such  a  catalog  you  need  to  register  with  your  user  name  and
password. Only then you can use the objects of this catalog. 

The  pCon.catalog  client  offers  a  Login  Manager  that  saves  the  user  access  data  and
provides them on demand during the login.

The Login Manager is enabled by default (Figure 9). Further to this option you can enable
the  entry  "Automatic  login"  which  makes  it  unnecessary  for  you  to  confirm  your
password and user name each time you open protected catalogs. 

Downloading objects

The  Online-Catalog  client  provides  access  to  a  great  variety  of  online  catalogs.  They
contain 2D and 3D objects  provided by various manufacturers and dealers. The objects are
available for free download (please see above). 

The  process  of  downloading  and  inserting  objects  into  a  planning  is  explained  with  the
example from the previous chapter.

Figure 10

Step by step the rooms on figure 6  are  to
be  equipped with  the  following  items  from
the “World of Furniture” catalog:

· desk

· chair

· office cupboard

· floor lamp

· plant

To insert the items above carry out the following instructions:

· Click  the Catalog  button  (Insert  group on  Home tab  or  Symbol  group on  Insert  tab)  to
open the home page of the online catalog client.

· Click “World of Furniture”.

· First click the “Office elements” folder, which contains subfolders with chairs and desks.

· Click the subfolder “Tables/linked tables” and choose a table for the office.

· Click the desired table to start the download.

· The object is now attached to  your  mouse  pointer. Click  at  the desired  position  in  the
office to place the desk there.

· Click the Catalog button again to download more objects. Navigate to the relevant folders. 

http://pcon-catalog.com/furniture/
http://pcon-catalog.com/furniture/
http://pcon-catalog.com/furniture/
http://pcon-catalog.com/furniture/
http://pcon-catalog.com/furniture/
http://pcon-catalog.com/furniture/
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Figure  11  shows  a  room  with  all  above  mentioned  objects.  After  you  have  inserted
elements  from the  online  catalogs,  they can  be  edited  and  aligned.  Figure  12  shows  the
rearranged furnishings in the example office.

Figure 11 Figure 12

Note

You may find a great variety of materials / textures for the object surfaces in the
catalog "World of Materials". 

Behaviour of the pCon.catalog window

Figure 13

After inserting an object from the pCon.catalog into
your planning the pCon.catalog window pops up
again.

If you don't wish that you can open the object settings
in the Objects group on the Insert tab (encircled arrow
on figure 13) and disable the option "Reopen catalog
window after insert operation". The catalog window
will now close after inserting an object.

3.7.4.2 3D Warehouse

Click the 3D Warehouse button on the Home tab or Insert tab to open a web application -
 quite  similar  to  a  browser  -  that  gives  you  access  to  the  contents  of  the  Google  3D
Warehouse.

There you can  search  for objects  and download  them  right  into  your  planning  in  pCon.
planner 6.

The data of the Google 3D Warehouse are primarily SKP files. These files can be downloaded
from the versions 5 - 7 of the 3D Warehouse.

http://pcon-catalog.com/materials/
http://pcon-catalog.com/materials/
http://pcon-catalog.com/materials/
http://sketchup.google.com/3dwarehouse/
http://sketchup.google.com/3dwarehouse/
http://sketchup.google.com/3dwarehouse/
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Figure 1

3.7.4.3 Importing object files

The  Objects  button  in  the  Objects  group  (Insert  tab)  or  the  Import  command  in  the
Application Menu allow you to import a variety of different file formats into pCon.planner 6.

Contents

1.Possible file formats

2. Importing objects

3. Importing objects on invisible layers
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Possible file formats

The following file formats can be imported in pCon.planner:

· DWG: pCon.planner 6 can read this format in all  its versions and allows to write in the  file
versions R15-R17. We strongly recommend  to  safe DWG  data in the  latest  version  of  the
format.

· DXF:  DXF  is  another  format  for  planning data,  along with  DWG. pCon.planner  6  can read
and write this format.

· SAT/SAB:  ACIS  SAT  files  are  used  in  CAD  systems  such  as  SolidWorks,  Solid  Edge  or
Unigraphics/NX. You can load these data with pCon.planner.

· 3DS: 3DS is an older but still  very  widespread  exchange  format  for 3D applications.  It
can very easily be inserted in pCon.planner 6 planning files. 

· SKP: Via the 3D Warehouse button (Objects group, Insert tab) you can insert SKP files from
the Google 3D Warehouse right into pCon.planner 6. Read more here.

· FML:  FML is  a format  for  geometric  object  data.  It  has been made  well-known  by  the
predecessor versions of pCon.planner 6 and can easily be processed.  

· ENV: ENV is just like FML a format by EasternGraphics. It comprises space planning data
such as walls, windows, light sources and so on.

· OBK: OBK is  the primary  file format  of  the order  tool  pCon.basket.  It  comprises the
FML format, which is loaded into your planning when importing OBK data. 

· OGRP: An OFML group may contain single data as well as grouped object data. It is usually
exported  from  pCon.planner  5  and  pCon.configurator  5  and  can  be  loaded  in  pCon.
planner 6.

Further to the file formats described above you can import the picture formats JPG, BMP,
TIF, GIF, PNG and TGA. Please go to chapter "Inserting pictures" to get more information.

Importing objects

To import one of these file types just follow these steps:

1.Click the Objects button in the Objects group on the Insert tab or the Import command
in the Application Menu. The file dialog box opens.

2.In the dialog box select a file and click "Open". The file is now imported into pCon.planner
6.

3.If in the file you want to import the scaling unit is not defined, the dialog as to be seen
on  figure  1  pops  up.  Now  you  need  to  define  the  scaling  unit  yourself,  before  the
geometry can be imported in pCon.planner.

The scale dialog helps you in the following ways: The upper part of the dialog displays the
dimensions of the geometry, below you are recommended a scaling unit (in this example it is
Inch). The dimensions that result from this scaling unit  are  given  in the  lower  part  of  the
dialog. 

If  you require  another  scaling unit  just  make your  selection  in the  box.  Furthermore,  you
can scale free-hand by entering a value for the "Width", "Height" and "Depth".

http://www.easterngraphics.com/
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Figure 1

Importing objects on invisible layers

If you try to import an object that is located on an invisible layer (which you have hidden
in  a prior  step)  you will  be shown an  additional  dialog  during  the  importing  process.  The
following example illustrates such a situation:

You  have  created  room  as  to  be  seen  on  figure  2.  The  room  is  located  on  the  layers
72_EGR_ROOM5_D2_WALL,  72_EGR_ROOM5_D3_WALL  and  72_EGR_ROOM5_D3_FLOOR.  Now
you save the drawing as a DWG file.

Figure 2
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Figure 3

Now  hide  all  layers  that  belong  to  the  room
(Figure 3). The room is no longer visible. 

If  you  now  import  the  room  that  you  have
previously  saved  via  the  Objects  button  (Insert
tab, Objects group) or via the Import command in
the  Application  Menu,  the  dialog  of  figure  4
appears. 

Click  "Yes"  to  unhide  the  layers.  The  room  is
now imported. 

If you click "No" the import is canceled.

After the import you can hide the layers again.

Figure 4

3.7.4.4 Inserting pictures

pCon.planner 6 allows you to import picture files of the formats  JPG, BMP, TIF, GIF, PNG
and TGA into your planning.

The following example explains the insertion process:

1.First switch to one of the isometric camera views or the perspective view. Then click the
"Picture"  button  in  the  objects  group of  the Insert  tab  or  in the  Insert  group  of  the
Home tab.

2. In the dialog select a picture file and press "Open".

3.Click the viewport to set the origin of the picture. Move the mouse away from that point
to open the picture(Figure 1).

4.Alternatively you can type in precise values in the fields right next to the mouse pointer. 

5.The upper value is the offset value which indicates the current  distance between the
wall and the picture (Figure 1). You ought to define a minimum distance (e.g. 1 cm) to
 prevent the flickering effects that occur whenever two objects (e.g. a picture  and  the
inside of a wall) are located on one and the same layer.  

6.Click again to finish the insertion process or press Enter to confirm the values. 
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Figure 1

3.7.4.5 Inserting texts and annotations

pCon.planner  6  allows  you  to  insert  texts  and  annotations  into  your  planning.  The
difference between both is that annotations display an arrow, whereas texts don't. 
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Figure 1

Both  tools  are  shown  in  figure
1. 

In  the  example  we  have
entered 

· the  texts  "Office  1,  Sales,
Anna  Smith,  Thomas  Grey"
and  "Office  2,  Assistant,
Susan Burke" 

as well as 

· the  annotations  "Window",
"Wall opening" and "Door".

Text 

To insert texts follow these steps:

1.Click the Text button in the Objects group on the Insert tab. The text dialog opens.

2.Define the fond and the text height.

3.Enter a text. Press Enter to insert line breaks.

4.Click OK to finish.

5.The text is now attached to the cursor and can be placed anywhere  in the planning by
mouse click.

To edit a text just select it and click the Pencil icon next to the text. The text  editor  re-
opens and you can make the modifications. Alternatively you can press "Enter" or "Edit  text"
in the Context Menu (opens on right-click).

In order to position a text in the drawing just modify  the values in  the  input  fields  right
next  to  the  cursor.  The  upper  value  determines  the  distance  of  the  text  to  the  closest
object, e.g. a wall. To prevent flickering it is recommendable to always enter a small offset, e.
g. 1 cm.

Note

1.Entering an offset value for texts is generally possible in  all  camera views.  In  2D
views though, the values refer to the spatial relation of the texts to coordinate
axes and not to another object.

2.Flickering effects may occur when two objects  - e.g. a text  and  the  inside  of  a
wall - are on one and the same layer (figure 2).
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Annotations
To insert annotations just follow these steps:

1.Click  the  Annotations  Icon  in  the  Drawing  Elements  group  on  the  Insert  tab.  (The
tooltip says: Insert a text box which refers, with the help of an arrow, to the desired point
of the drawing). A text dialog opens.

2.Define the fond and the text height.

3.Enter a text. Press Enter to insert line breaks.

4.Click OK to finish text entry.

6.The annotation text is now attached to the cursor and can be placed anywhere  in  the
planning by mouse click.

7.Then move the mouse  to  the object  the  text  refers to  and click  there.  The  arrow is
now  displayed.  The  arrow  can  consists  of  several  parts.  The  drawing  process  is  then
finished via the Context Menu entry "Finish" or the ESC key.

To edit a text just select it and click the Pencil icon next to the text. The text  editor  re-
opens and you can make the modifications. Alternatively you can press "Enter" or "Edit  text"
in the Context Menu (opens on right-click).

In order to position a text in the drawing just modify  the values in  the  input  fields  right
next  to  the  cursor.  The  upper  value  determines  the  distance  of  the  text  to  the  closest
object, e.g. a wall. To prevent flickering it is recommendable to always enter a small offset, e.
g. 1 cm.

Note

1.The  arrow  of  an  annotation is  always  connected  to  the  text  of  the  annotation.
That means that moving the text also moves the arrow.

2.Die Eingabe eines  Abstandswertes  bei  Anmerkungen  ist  grundsätzlich  in  allen
Kameraansichten  möglich,  jedoch  beziehen  sich  die  eingegebenen  Werte  bei  2D-
Einstellungen  auf  die  Position  der  Koordinatenachsen  und  nicht  auf  ein  anderes
Objekt.

3.7.5 Illumination

Figure 1

pCon.planner provides you with different light
sources  for  illuminating  your  room  and
furnishing  elements.  To  insert  light
sources,  or  to  display  existing  ones  in  the
planning,  click  the down arrow  next  to  the
room  elements  on  the  Home  tab  or  the
Insert tab.  In Figure 1 this arrow is encircled.

You  can  choose  between  spotlight,  point
light and directional light.
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Contents

1.Spotlight

2.Directional light

3.Point light

4.Default illumination

3.7.5.1 Spotlight

Spot light projects a cone of light onto your planning. This cone of light can be configured
in regard to the angle of beam, the range, color, direction, intensity and shadow.

The application and properties of spot light will be discussed as follows.

Application of spotlight

The application of spot light is versatile. You can illuminate entire designs, but you can
also simulate the light of a single floor or desk lamp. 

Figures 1 and 2 show different options for applying spotlight.

Figure 1 Figure 2

To insert spot lights follow these instructions:
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Figure 3

1. Click the down arrow next to the
room items  on  the  Home  tab  or
the Insert tab. (see here)

2. In  the  lighting  category  click
“Spot  light”.  Click  inside  the
viewport to position  the  source  of
the spot light.

3. Now move the mouse pointer to
 determine  the  target  that  you
want to illuminate and fix it by a
mouse  click.  The  point  that  you
click  is  the  center  of  the  light
circle projected by the spotlight.

Spotlight properties

Spot light features some properties which you can edit with the mouse and/or in the
Properties dialog box. 

Position

To change the position of a directional light use one of the three options describes below:

Option 1:

The position of the spotlight can be changed by the entry of the coordinates for x, y and z
(red, green and blue axis) in the Properties dialog box. These coordinates refer to the source
of the light (Figure 3).

Option 2:

Another possibility to modify the position of the spotlight is to move the ledger lines. They
run from the source of the light to the light circle and visualize the cone of light (please see
dihedral angle). When you move the cursor over the lines they are displayed in light green
. Now you can select a line and move it. Another click fixes the new position of the light. 

Figure 4 displays the spot light with its ledger lines in a lateral view, figure 5 in the top view. 
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Figure 4 Figure 5

Option 3:

The third option is to move the light symbol (Figure 4). Click the symbol, move it  to
its new position and click again to fix it.

 

Direction 

Every spot light radiates into a certain direction. When you select  a  spotlight  with  your
mouse, the middle ledger line indicates the direction (see Figure 4). Two interactors  allow
you to change the direction. 

· The first interactor is the source interactor. It is located at the source of the light and is
highlighted in light green on figure 6.

· The  other  interactor  is  the  target  interactor  which  is  located  at  the  end  of  the  middle
ledger line (highlighted in light green on figure 7).

Figure 6 Figure 7

To change the direction of the spotlight follow the steps below:

1.Move the mouse pointer onto one of the interactors. The interactor will change to light
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green.

2.Click and move the interactor.

3.Click again to confirm the new direction of the light. 

Dihedral angle

The dihedral angle specifies the size of the cone of light. It can range from 1° to 170°.
You can set the angle either in the  or you can use the light circle described above.  

Figure 8

1.Move the mouse over the light
circle (Figure 8). The circle will be
displayed in light green.

2.Now click the circle and move the
mouse to modify its diameter. 

3.Click again to confirm the new
dihedral angle.

Range and intensity

The range specifies the distance which the beam illuminates. It is specified in meters and
can be changed in the Properties dialog box.

The intensity  of  the  cone of  light  directly  depends  on  the range.  The  intensity  at  the
source of the spotlight can be specified in the Properties dialog box and ranges from 0 (no
light)  to  1  (full  intensity).  It  is  highest  right  at  the  light  source  and  decreases  with
growing distance. At the end of the distance it is 0.
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Figure 9

Note

As you can see in figure 9 the range and the length of the ledger lines are not
related to each other.

Color

The color of the spot light can be determined in the Properties dialog box. The default color
is white.

Shadow

pCon.planner can calculate shadows. To apply shadows, “Shadow" has to be checked in
the Properties dialog box.

Shadow is only displayed in the perspective camera view. The other views do not support
shadows.
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Note

The shadows of manually applied spotlights are disabled by default. Check
"Shadows" in the properties dialog box to display the shadows.

Switch spotlight on and off

The spotlights can be switched on and off via the Properties dialog box, as well. Check the
entry "Light Source" to switch it on and uncheck it to switch the spotlight off.

Display / hide spotlight elements 

You can display or hide the spotlight symbol. Simply click the arrow next  to  the  Layer
symbol  on  the  Edit  group  (Home  tab)  to  open  the  Layer  control  dialog.  Then  check  /
uncheck "Show lighting".  All  light  symbols  (not  only  the  spotlight)  will  be  displayed  /
hidden. 

Whether you show or  hide  the  lighting  symbol  has NO effect  on  the illumination  of  your
planning.

3.7.5.2 Directional light

A  directional  light  source  projects  parallel  light  beams  onto  your  planning.  It  can  be
configured in direction, intensity, shadow and color.

The application of directional light and its properties are discussed as follows.

Application of directional light

Directional light applies consistent light to the entire planning. The parallel character of the
light makes it very similar to sunlight.

Figures 1 and 2 show two examples of how directional light was used for illumination. 
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Figure 1 Figure 2

In order to apply directional light to your planning follow the steps below:

Figure 3

1.Click the down arrow  next  to  the
room items on the Home tab  or  the
Insert tab (see here). 

2. In  the  lighting  category  click
“Directional light”.

3.Click  inside  the  viewport  to
position the light source.

4.Now click the target (see figure 3)
to  determine  the  direction  of  the
beam of light.

Directional light properties

Directional light features some properties which you can edit with the mouse and/or in the
Properties dialog box.

Position

Option 1:

The position of the directional light can be changed by the entry of the coordinates for x, y
and z (red, green and blue axis) in the Properties dialog box. These coordinates refer to the
source of the light (Figure 3).

Option 2:

Another possibility to modify the position of the directional light is to move the ledger line.
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Directional  light  has  one  ledger  line  that  runs  connects  the  source  and  the  target  of  the
directional light. When you move the cursor over the line it is displayed in light green. Now
you can select the line and move it. Another click fixes the new position of the light. 

Figure 3 displays the directional light with its ledger line. 

Option 3:

The third option is to move the light symbol (Figure 4). Click the symbol, move it  to
its new position and click again to fix it.

Direction

The directional light features two interactors  that are used to  change the direction of the
beam of light. 

· The first interactor is the source interactor. It is located at the source of the light and
is highlighted in light green on figure 6.

· The  other  interactor  is  the  target  interactor  which  is  located  at  the  end  of  the  middle
ledger line (highlighted in light green on figure 7).

Figure 4 Figure 5

To change the direction of the directional light follow the steps below:

1.Move the mouse pointer onto one of the interactors. The interactor will change to light
green.

2.Click and move the interactor.

3.Click again when the arrow points into the desired direction. 

Since  the  directional  light  is  quite  similar  to  sunlight,  it  does  not  only  radiate  from  its
source but it emits parallel beams of light.

In contrast to spotlight and point light, the light source does not actually emit  the light;
therefore it is not dark behind it. The light source simply indicates the direction of the light
beams. This specific characteristic is visualized in Figure 6.
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Figure 6

Intensity

The  intensity  specifies  the  brightness  of  the  incoming  light.  In  contrast  to  spotlight  or
point light, the intensity  of directional light is identical everywhere  in  the planning.  It  is
not related to the distance from the light source.

The intensity at the source of the directional light can be specified in  the Properties  dialog
box and ranges from 0 (no light) to 1 (highest intensity). 

Color

The color of the directional light can be determined in the Properties dialog box. The default
color is white.

Shadow

pCon.planner can calculate shading. To apply shading, “Shadow" has to be checked in the
Properties dialog box.

Shadow is only displayed in the perspective camera view.  The  other  views  do  not  support
shadows.
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Note

The shadows of manually applied spotlights are disabled by default. Check
"Shadows" in the properties dialog box to display the shadows.

Switch directional light on an off

All  illumination  used  in  your  planning  can  be  switched  on  and  off  via  the  Properties
dialog box. Check the entry "Light Source" to switch all light sources on and uncheck to
switch them off.

Display / hide directional light elements

You can display or hide the directional light symbols. Simply click the arrow next to the
Layer symbol on the Edit group (Home tab) to open the Layer control dialog. Then check /
uncheck "Show lighting".  All  light  symbols  (not  only  the  Spotlight)  will  be  displayed  /
hidden. 

Whether you show or  hide  the  lighting  symbol  has NO effect  on  the illumination  of  your
planning.

3.7.5.3 Point light

The point light emits light in a 360° angle from the light source into all directions (see
Figure 3). It can be modified in color, intensity and range.

The application of point light and its properties are discussed as follows.

Application of point light

The application of point light is primarily used to light up specific objects. Figures 1 and 2
show two examples how point light was applied to achieve just that. 

Figure 1 Figure 2
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To apply point light sources to your planning follow the steps below:

1.Click the down arrow next to the room items on the Home tab or the Insert tab (see
here).

2.In the lighting category click “Point light”.

3.Click inside the viewport to position the light source.

Point light properties

The point light properties can be modified in the Properties dialog box or with the mouse.

Position

Option 1:

The position of the directional light can be changed by the entry of the coordinates for x, y
and z (red, green and blue axis) in the Properties dialog box. These coordinates refer to the
source of the light (Figure 3).

Option 2:

Another option is to move the point light symbol. Click the symbol, move it to its new
position and click again to fix it.

Intensity and range

The range specifies the distance to which the light source shines. The range is specified
in meters and applies to all directions equally.

The  intensity  specifies  the  brightness  of  the light  source.  It  can be modified  in the  the
Properties  dialog  box  and  ranges  from  0  (no  light)  to  1  (full  intensity).  The  intensity
decreases linearly  with growing distance  until  it  reaches  zero  out  of  the  previously set
range.
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Figure 3

Color

The color of the point light can be determined in the Properties dialog box. The default color
is white.

Switch point light on and off

All  illumination  used  in  your  planning  can  be  switched  on  and  off  via  the  Properties
dialog box. Check the entry "Light Source" to switch all light sources on and uncheck to
switch them off.

Show / hide point light elements

You can display or hide the point light symbols. Simply click the arrow next to the Layer
symbol  on  the  Edit  group  (Home  tab)  to  open  the  Layer  control  dialog.  Then  check  /
uncheck "Show lighting".  All  light  symbols  (not  only  the  Spotlight)  will  be  displayed  /
hidden. 

Whether you show or  hide  the  lighting  symbol  has NO effect  on  the illumination  of  your
planning.
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3.7.5.4 Default lighting

Whenever you load a drawing pCon.planner applies the default sources of light. These aim
at guaranteeing a basic illumination of your drawing. The default lighting consists of three
directional lights from the directions X, Y and Z.

The shadows of the lights are disabled by default. Via the Properties dialog box you can
activate the shadows of each of the three lights individually.

If you have deleted the default illumination by accident, you can reapply it via the entry
"Default lighting" in the Room group on the Insert tab (figure 1).

Figure 1
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3.7.6 Drawing elements

Figure 1

The Drawing elements group on the Insert tab provides a number
 symbols, which you can insert into  your  project.  This  chapter
shows you how to create and edit such objects.

Contents

1.Creating drawing elements

2.Moving drawing elements

3.Rotating drawing elements

4.Scaling drawing elements

5.Extruding drawing elements

6.2D symbols catalog

3.7.6.1 Creating drawing elements

The pCon.planner allows you to create two- and three-dimensional  drawing elements  in
your planning. Since the creation of the individual  drawing elements is  very similar  we
will only explain how to create a rectangle. Information on special elements are given at the
end of this chapter.

Contents

1.Creating drawing elements

1.Offset value

2.Color

2. Information on further drawing elements

1.Polygon

2.Line/Polyline

3.Measurements

Creating drawing elements

To create a rectangle do the following:

1.Click “Rectangle” in the Drawing elements group on the Insert tab.

2.Click the viewport to start drawing. Alternatively you can enter exact values with your
keyboard to set the origin of the object. Confirm each entry with Enter.

3.Move the mouse pointer to resize the rectangle, starting from its origin and click to
complete the rectangle.

4.Or: Enter the size with your keyboard and press Enter. 
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Offset value

Some drawing elements display a third value - the offset -  during the drawing process. This
value allows you to position the drawing element by a minimum distance above another
object.  Thus  flickering  effects  are  prevented  that  would  occur  when  two  objects  are
located on one and the same layer.  

Figure 1

Color

Bild 2

Before you start to create a drawing element you can determine
its color and apply a filling.

To do this click the arrow (encircled on figure 2) in the Drawing
Elements  group  (Insert  tab)  and  select  the  appropriate
entries in the dialog box. 

Note

You can change  the fill  color  of  drawing  elements  at  any  later  time.  Please  click
here for more information. 
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Information on further drawing elements

Polygon

To  draw a polygon  just  draw all  necessary  lines  after  another.  When  you finished the
polygon press Enter or click "Finish" in the context menu.

Line/Polyline

Similarly  to  the  polygon  you  can  press  Esc  or  select  "Finish"  in  the  context  menu  to
complete a polyline.

Measurements

To  complete the  entry  of  measurements  press  Esc  or  select  "Cancel"  in  the  context
menu.

3.7.6.2 Moving drawing elements

Use the Move tool for repositioning drawing elements 2D and 3D objects in the planning.

To move objects do the following:

1.Select  the  relevant  element.  Click  again  either  edge  or  surface  of  the  element  to
activate the move mode.

2.Move the mouse pointer to reposition the object.

3.Click at the desired location to complete the moving.

Note

1.For more information on moving objects please refer to chapter Functions and tools /
Move. 

2.Alternatively to manual moving enter specific values.

3.7.6.3 Rotating drawing elements

Use the Rotate tool for rotating 2D and 3D objects in the planning.

To move objects do the following:

 

1.Double-click the relevant element to start the Rotate tool.

2.Click again to set the starting point of the rotation.
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3.At this point you start with the rotation of the object.

4.Next to the mouse pointer the current rotation angle in degrees is given.

5.Click to complete the rotation.

Note

1.For more information on rotating objects please refer to chapter Functions and tools /
Rotate.

2.Alternatively to manual rotating enter specific values.

3.7.6.4 Scaling drawing elements

Use the Scale tool for scaling drawing elements in the planning.

To scale objects do the following:

 

1.Select the object you want to scale.

2.Click the Scale tool in the Tool group on the Edit tab.

3.Click one of the interactors and move the mouse pointer to scale the object.

4.Click to complete the scaling.

Note

1.For more information on scaling objects please refer to chapter Functions and tools /
Scale.

2.Alternatively to manual scaling enter specific values.

3.7.6.5 Extruding drawing elements

Rectangles, circles, ellipses, polygons and polylines (interconnected lines) can be extruded to
three-dimensional objects.

To extrude objects do the following:

 

1.Select the two-dimensional object you want to extrude.

2.Click the Extrude tool in the Tool group on the Edit tab.

3.Click the edge or surface of the two-dimensional element to start the extrusion.

4.Move the mouse pointer to extrude the element.

5.Click to complete the extrusion. The tool remains active so that you can continue
extruding another element.
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Note

1.For more information on extruding objects please refer to chapter Functions and tools
under Extrude.

2.Alternatively to manual extruding enter specific values.

3.7.6.6 2D symbols catalog

The 2D symbols catalog is a web catalog. It contains various symbols, such as borders
for drawing, title blocks, office furniture but also pictographs. The catalog  is  constantly
being extended.

All objects are available as two-dimensional plannings and greatly extend your possibilities
when  designing  a room. You  can access  the  2D  catalog  either  in  any  browser  or  via  the
pCon.catalog website or via the pCon.planner according the instructions given below.

Figure 1

In  the  Insert  group  on  the  Home  tab  as  well  as  in  the
Drawing  Elements  Group  on  the  Insert  tab  you  find  the
Drawing Elements. Click the arrow encircled on figure 1
to open the menu.

Figure 2

At  the  bottom  of  this  menu  you  find  the  menu  item  "More
shapes...".  When  you  click  this  item,  the  2D  symbols  catalog
opens in the pCon.catalog window. 

Figure 3 shows the interface of the 2D Symbols Catalog. Open the appropriate folder and
select an element for your drawing.

http://www.pcon-catalog.com/
http://www.pcon-catalog.com/
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Figure 3

Figure 4 shows a title block and  a border  for drawing  in  combination with  other  drawing
elements as an example.
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Figure 4
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3.8 Presenting the planning

pCon.planner  features  a  Presentation  mode  for  highly  professional  and  impressive
presentations  of  your  plannings  to  your  customers  and  business  partners.  It  works  in  the
Full  Screen  mode.  Your  possibilities  of  interaction  are  restricted  to  navigation  and
changing  the  quality  of  visualization  and  the  camera  perspective.  Thus  you  cannot
accidentally move items or make any changes to your planning during the presentation.

Furthermore, the pCon.planner provides a tool to create animations  of  your  drawings.  The
animation can then be exported as  a sequence  of  pictures  and  converted  into  a video
with  common  video  editing  software,  e.g.  Windows  Movie  Maker,  Virtual  Dub  or  Quick
Time. 

The following chapters explain how to use the presentation mode and the animation tool.

Contents

1.Presentation

2.Animation

3.8.1 Presentation

Contents

1.Starting and quitting the presentation

2.Navigating in the Presentation Mode

3.Rendering modes

4.Camera perspectives

Starting and quitting the Presentation mode

There are three options for starting the Presentation mode:

· Press "F12". 

· Click the Presentation icon in the status bar.

· Click the Presentation button on the View tab.

There are also tree options for quitting the Presentation mode:

· Press "Esc".

· Press "F12".

· Click "X" in the upper right corner.

Navigating in the Presentation Mode

In the Presentation mode you can use the following options for navigation:

· Walkthrough Interaction Mode
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· Zooming via scroll wheel or the following keyboard shortcuts:

· "Strg" + "+" (zoom in),

· "Strg" + "-" (zoom out),

· "Strg" + "Space" (show the full extent of the active viewport)

· WASD navigation

· Up and down movement in the Perspective camera view:

· "R": moving up

· "L": moving down

· Orbit mode

· Pan mode

Rendering modes

You  can  switch  between  the  different  rendering  modes  using  the  following  keyboard
shortcuts: 

· "Shift" + "F1": Wire frame mode

· "Shift" + "F2": Hidden line mode

· "Shift" + "F3": Colored mode

· "Shift" + "F4": Conceptual mode

· "Shift" + "F5": Shaded mode

· "Shift" + "F6": Realistic mode

Camera perspectives
After starting the Presentation mode the planning is displayed in the camera perspective
that was previously active. Of course you can use any other camera perspective, as well.
Just click the red camera view in the upper left corner and select the desired view.
Alternatively you can use the following keyboard shortcuts to change the camera
perspective:

· "Ctrl + Shift + F1": Perspective 

· "Ctrl + Shift + F2": Front

· "Ctrl + Shift + F3": Top

· "Ctrl + Shift + F4": Left

· "Ctrl + Shift + F5": Right

· "Ctrl + Shift + F6": Rear

· "Ctrl + Shift + F7": Bottom

· "Ctrl + Shift + F8": North East

· "Ctrl + Shift + F9": North West
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· "Ctrl + Shift + F10": South East

· "Ctrl + Shift + F11": South West

3.8.2 Animation

pCon.planner features a tool to create and record animations which is explained in the
following chapter.

Inhaltsübersicht

1.Create and play an animation

2.Animation along a path

3.Record the animation

Create and play an animation

Figure 1

In order to create an animation click "Edit" in the Animation Group
on the Presentation tab. 

Now the  Animation  Editor  opens  (Figure  2). This  editor  allows  you  to  create  individual
animations.  You  can  set  individual  camera  positions  or  select  existing  cameras  to
apply them to the animation. Furthermore, the editor offers various options for the type and
sequence of the animation. 
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Figure 2

The  editor  is  divided  into
three parts. 

· On the  left  side  you  find
the  settings  and
functions  that  are
needed  to  create  an
animation. 

· On the right side you can
 set  individual  camera
positions  for  the
animation  and  make  the
settings  for  each
position.

· In the lower part you find
two  buttons:  With  the
"Play"  button  you  can
start  the  animation.
After  starting  it  this
button  converts  into  the
Pause  button  which  can
be  used  to  interrupt  the
animation.  The  "Stop"
button stops playing the
animation. 

Figure 3

Alternatively  you  can  use  the  "Play"  button  in  the  Animation
group  on  the  Presentation  tab  (Figure  1).  Then  the  Animation
player opens (figure 3) and you can use the  buttons  "Play",  "Pause"
and "Stop".
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Figure 4

To create a new animation click the green  in the Animation
editor. An animation with the name "Animation 1" is generated.
If this name is already  occupied  the  animation will  get  the  next
number in numerical order (Animation 2).

Now  you  can  modify  the  name.  The  text  is  selected
automatically  and  you can  enter  a new  name.  Press  Enter  to
confirm your entry. If  you should like  to  change the  name later
you just need to select the animation and press Enter. Now you
can edit the name. 

With  a  click  on  the  red   you  can  delete  a  selected
animation.  Alternatively  you  can  press  Enter  after  selection.
Please  bear  in  mind  that  deleting  the  animation  cannot  be
undone!

With  the  symbols   "Create animation  along  path"  and  
"Create animation along path around target  point"  you can
define a camera path (for example with drawing elements)  along
which the  camera  moves around an  object.  Read  more  under  "
Animation along a path" later in this chapter.

Furthermore,  you  can  edit  the  properties  of  an  animation.
Check  "Close  Path"  if  you want to  close the  camera  path.  In
this case the camera moves from the last position to the first
position. 

Under  "Interpolation"  you  can  select  the  modes  "Straight",
"Smooth" and "Curved". In "Straight" animations  the  camera
moves  straight  between  the  different  positions.  In  a
"Smooth"  animation  the  camera  paths  are  straight  but  the
change of the direction is performed as a smooth curve. And
if  you  activate  "Curved"  the  camera  performs  a  curve
between the single positions.Theoretically  you could  generate
a circular camera ride with this setting.

At last the  duration  of  the  animation as  well  as  the  length  of
the path are displayed.

Figure 5

· The  single  camera  positions  are  defined  in  the  right
part  of  the  animation  editor  under  "Positions".  Follow
these steps to create a new path:

1.Select  an  animation  to  which  you  want  to  add
the positions.

2.Switch  to  your  drawing  and  select  the
Perspective camera view.

3. In the drawing navigate to  an  appropriate view
for the first position. 

4.Click   "Grab  new  position  from  selected
view". The current view is added  as first camera
position.

5.Repeat steps 1 to 4 until you have  simulated  the
desired camera path.
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Alternatively you can click the camera icon . A list
with all  cameras that you have placed in your drawing  is
displayed.  With a  click  onto  one  of  the  cameras  it  is
added to the path.You can modify  the name  of  each
position.  After setting the  position  the  text  is  selected
automatically  and  you  can  enter  a  new  name.  Press
Enter to confirm. If you should like  to  change the  name
later you just need to select a position  and  press  Enter.
Now you can edit the name. 

· To delete a position or camera, select it and  click  
"Delete selected position(s)".

· To change the order of the positions / cameras, select

one of the positions / cameras and press   or .
Alternatively you can move the positions / cameras by
Drag & Drop.

· If  you want to  edit  a  position  at  a  later  time  do  the
following:

1.Activate the position by double-click in the position
list  of  the  animation  editor.  The  position  will  be
displayed in your drawing. 

2.Modify the view. 

3.Click  in the animation editor to assign the
current view to the selected position.

· Last  but  not  least  you can edit  the  camera  speed  as
well as the pause time between the positions.

· If  you  click  "Fixing  viewing  direction"  the  viewing
direction remains fixed until the camera reaches the next
position.

· "Interpolate  viewing  direction"  smoothes  the  change
of the viewing direction during a position change.

Figure 6 illustrates the path of an animation in blue. The single positions and viewing
directions are marked with short blue arrows. If you select a position in the animation
editor the corresponding arrow is highlighted in orange.
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Figure 6

Animation along a path

 

Figure 7

You have the  possibility  to  create  an  animation along  a shape
or along a drawing element. 

To  do  this  you  first  need  to  draw  a  shape  without  filling
(deactivate "Draw with filling" before you draw  the  object  - figure
7) and select it.

Figure 8

In  this  example  a  circle  was  drawn  around
the  object.  The  circle  will  still  be  in  the
drawing after  creating the  animation and  can
be reused at any time.
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Figure 9

To  create  the  animation  along  this  circle
follow these steps:

1.Select the circle.

2.Click  "Create animation along path
"  in  the  animation  editor.  The  animation
path is displayed in blue.

3.Click the path to set the starting point
of the animation.

4.Click  again  to  define  the  direction  of
the  animation.  The  direction  will  be
indicated by an orange arrow.

The animation is now created.

In  this  example  the  camera  moves  counter-
clockwise along the circle. 

Figure 10

To  create  an  animation  along  this  circle
around  the  piece  of  furniture  follow  these
steps:

Select the circle (drawn without filling)

1.Click  "Create animation along path
around  target  point"  in  the  animation
editor.  The  circle  now  turns  into  the
animation path. 

2.Now  click  the  target  point  (in  this
example  the  center  point  of  the  circle)
and  again  to  set  the  direction  of  the
path.

The  camera  will  now  perform  a  movement
around the target point. 

Record the animation

With a click on "Record" in the Animation Group you activate the Animation Recorder.
There you can adjust the settings for the export of your animation as sequence of pictures.
In the top part you can select the animation to be recorded. 
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Figure 11

On the  Output  tab  (figure  11)  you  can  select
the  output  folder.  Click  the  Folder  icon  and
select  a  folder  in  the  dialog.  Alternatively  you
can click the path and enter it manually. A folder
with the name of the animation is created. When
you  start  the  record  process,  pCon.planner
saves the sequence of pictures in this folder.

Furthermore,  you  can  set  the  resolution,  the
picture format and  the  frames  per  Second  in
this dialog.

Alternatively  you  can  select  a  standardized
profile. Please note that some of the options are
only available in pCon.planner Pro.

The  option  "Keep  view  aspect  ratio"  reduces
the  size  of  the  pictures  in  terms  of  hight  and
width  to  match  the  size  of  the  pictures  with
the size of the viewport.

Figure 12

On the Options tab you can select  the  quality
and the background color (figure 12).

There  are  three  selectable  levels  of  quality:
"Standard",  "High"  and  "Very  High".  For
optimum results you should select  "Very  High".
In this case though, the recording  time  will  be
much  longer  depending  on  the  size  of  the
drawing and performance of your computer. 

Furthermore,  you  can  select  a  background
color or use the view background.

Click "Start" at the bottom of the Animation Recorder to start the record process. You may
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be displayed a warning that you have selected an output setting that is only available in the
pCon.planner Pro. In this case select the settings 480 x 388 or smaller.

Furthermore,  you  may  be  noticed  that  there  is  already  a  folder  with  the  name  of  the
animation. You can either overwrite the files of this folder or rename the path or the name of
the animation.

Figure 13

When  the  record  process  starts,  a  window
displays the  record  status  of  the  picture  as
well as of the complete animation.

Along  with  the  number  of  the  currently
processed  picture  and  the  percentage,  you
can see the elapsed time and the estimated
total time.

You  can  interrupt  the  recording  of  the
animation via the Pause button or cancel it.

Note

· You  can  select  several  animations/positions  by  moving  the  mouse  over  the
animations/positions. 

· When you move the mouse with the Shift key pressed the selected entry and all
that is above the entry is also selected. 

· To select several arbitrary entries press the Ctrl key and click the entries.



Copyright © 1995 - 2009 EasternGraphics. All rights reserved.


	Introduction
	What is the pCon.planner?
	Download, installation and updates
	How to work with the online help
	Technical hints and tips

	User Interface
	The Application Menu
	Create a new drawing
	Open an existing drawing
	Save a drawing
	Save a selection
	Import
	Export
	Print
	Send an e-mail
	Purge planning
	Document Properties
	Settings

	The Ribbon
	Home Tab
	Edit Tab
	Insert Tab
	Presentation Tab
	View Tab
	Help Tab

	The Quick Access Toolbar
	Add a command
	Hide a command
	Remove a command
	Move the Quick Access Toolbar

	Work Area and Viewports
	The Status Bar

	Furnishing with the pCon.planner
	How to use your mouse and keyboard
	Mouse
	Keyboard

	Select objects
	Object structures
	Methods of selecting

	Tools and functions
	Tools
	Draw
	Move
	Rotate
	Scale
	Extrude
	Curvature
	Array tool

	Functions
	Group and ungroup objects
	Control visibility
	Edge softening
	Assign colors
	Assign and edit textures
	Edit properties


	Navigation in the planning
	Zoom operations
	PAN mode
	Orbit mode
	WASD navigation
	Walkthrough Interaction Mode

	Camera settings and rendering modes
	Camera angles
	2D camera positions
	Isometric camera positions
	Perspective camera position
	Individual camera views
	Assign camera positions

	Rendering modes
	Wireframe mode
	Hidden line mode
	Colored mode
	Conceptual mode
	Shaded mode
	Realistic mode
	Extended rendering options

	Adjust rendering
	Show outlines
	Transparent walls


	Aligning objects
	Coordinate systems and reference point
	Aligning objects using the User Coordinate System
	Selecting and deselecting axes
	Using axis snap
	Using ojects snap
	Configure snapping types

	Design and furnish rooms
	Walls
	Drawing walls
	Moving walls
	Rotating walls
	Scaling walls
	Stretching and shortening walls
	Curving walls
	Extruding walls (adjusting the height)
	Connecting, disconnecting and splitting walls
	Grouping walls

	Doors, windows and wall openings
	Insertion process
	Modifying position and size
	Opening options for doors and windows
	Round wall openings and niches

	Floors
	Objects
	pCon.catalog client
	3D Warehouse
	Importing object files
	Inserting pictures
	Inserting texts and annotations

	Illumination
	Spotlight
	Directional light
	Point light
	Default lighting

	Drawing elements
	Creating drawing elements
	Moving drawing elements
	Rotating drawing elements
	Scaling drawing elements
	Extruding drawing elements
	2D symbols catalog


	Presenting the planning
	Presentation
	Animation



